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1 ВВЕДЕНИЕ 

1.1 Обзор руководства пользователя 

Руководство состоит из разделов, описывающих конфигурирование и использование системы 
MultiTrend. 

1.2 Аббревиатуры и определения 
 

Термин пояснения 
см Контроль коррозии 
SM Контроль грунта 
MT MultiTrend 
FBM Головной модуль FieldBus 
FSM Метод оценки характеристики электрического поля (также называемые 
FC Коэффициент FSM : Отношение величины, вновь замеренной на контактной паре к 
FSM-IT Измерительный прибор для оценки характеристики электрического поля 
MultiTrend Компьютерная программа, предназначенная для получения, обработки и 

отображения данных, полученных от измерительного прибора FSM 
ppt Частей на тысячу: 0,1% 
RS-232 Коммуникационный стандарт (последовательный). 
RS-485 Коммуникационный стандарт (последовательный). 
Характерист Контрольное измерение, с которым далее сравниваются все последующие 
Площадка Рабочая зона, где установлено оборудование FSM-IT  
LCA Анализ местной коррозии 
WT ТОЛЩИНА СТЕНКИ 

2 Основные данные 

2.1      Авторские права и лицензии 

Лицензионное соглашение с компанией CorrOcean ASA, входящее в комплект поставки ПО 
MultiTrend, устанавливает допустимые и недопустимые способы использования данного 
продукта.Не допускается воспроизводство или использование ПО MultiTrend без 
соответствующих полномочий. 

Copyright © 1997-2004 by CorrOcean ASA Trondheim, Norway. 
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3 ТЕХНИЧЕСКОЕ ОПИСАНИЕ 
MultiTrend является компьютерной программой для анализа коррозийного и эрозийного 
воздействия на основе данных FSM. Данный программный продукт рассчитан для работы под 
управлением операционной системы Microsoft Windows. MultiTrend может использоваться для 
конфигурирования и получения данных от множества типов контрольного оборудования, 
работающего на основе принципа FSM - такого как SandLoggers и MultiLoggers, FSM 
регистраторы, Станции G4 FSM. MultiTrend также поддерживает переносные измерительные 
приборы MultiCorr и FSM IT. 

3.1 Ключевые возможности 

� Конфигурирование измерительного прибора MultiCorr. В программе  MultiTrend можно 
определить датчики коррозии, а затем использовать их для конфигурирования прибора 
MultiCorr (определения корректного идентификатора и параметров). 

� Передача данных с устройства  
MultiCorr в ПК. 
� Управление и прием данных с подключаемых приборов и датчиков. 
� Осуществление анализа данных по коррозии и эрозии; построение диаграмм - 

графиков интенсивности коррозии, потери металла (в т.ч. средней). 
� Расчет интенсивности выноса грунта, построение соответствующих диаграмм (на 

основе данных по эрозии). 
� Управление датчиками ER-типа, датчиками грунта, типов LPR, PT, гальваническими, 
аналоговыми, а также датчикам контрольных пластин  потери металла. 
� Управление и конфигурирование функций установок FSM 
� Управление и конфигурирование функций установок  FSM IT 
�  Прием данных (FSM) с установок FSM 
�  Прием данных (FSM) с установок FSM IT 
� Обработка и анализ FSM-данных (путем построения по ним двухмерных и трехмерных 
диаграмм) 

3.2 Поддерживаемые измерительные приборы 

� SandLog 
� MultiLog 
� MultiCorr 
� Установка FSM G2 
� Установка FSM G4 
Измерительный прибор FSM-IT 
� FSM Log 

4 ПОДГОТОВКА И УСТАНОВКА 

4.1      Установка ПО MultiTrend 

Установочная программа MultiTrend произведет все необходимые действия, чтобы установить 
ПО MultiTrend на ваш компьютер.. Для запуска программы установки, вставьте CD-диск в 
привод компьютера; запуск установочной программы должен произойти автоматически. Если в 
вашем компьютере отключена функция автозапуска, необходимо вручную запустить файл 
SETUP.EXE, и далее, следовать инструкциям на экране. Во время установки вам нужно будет 
ввести номер лицензии MultiTrend. Этот номер проставлен либо на упаковке с  CD-диском, 
либо на отдельном листе бумаги. Ввод лицензионного номера необходим для того, чтобы 
программа работала с полной функциональностью. 

Для запуска программы при помощи команды "Выполнить...": 

1) Нажмите кнопку "Пуск", затем выберите "Выполнить....". 
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2) В открывшемся окне введите путь к файлу Setup.exe 
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Пользователь должен указать папку, в которую необходимо устанавливать программу 
MultiTrend, а также папку для размещения ярлыков программы. 

Во время установки некоторые из файлов копируются непосредственно в папку программы, а 
некоторые - в системную папку Windows. Кроме того, программа установки произведет 
необходимые изменения в системном реестре Windows. 

4.2      Удаление ПО MultiTrend 

Для полного удаления ПО MultiTrend, необходимо открыть "Панель управления" и дважды 
щелкнуть по иконке "Установка/удаление программ". В открывшемся диалоговом окне 
выберите пункт  MultiTrend и нажмите кнопку Добавить/Удалить. Во время процесса 
деинсталляции будут удалены только компоненты программы. Файлы с данными останутся на 
жестком диске - их нужно удалить самостоятельно, например, при помощи Проводника 
Windows. 
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5 ИНСТРУКЦИИ ПО ЭКСПЛУАТАЦИИ 

5.1      Обзор пользовательского интерфейса MultiTrend 
 

Рисунок 11 Главное окно программы MultiTrend 

На рисунке 11 показано главное окно ПО MultiTrend. Основные элементы окна: 

� Строка заголовка. Строка в верхней части окна.В левой части строки показано имя 
файла, содержащего текущую конфигурацию (в данном случае Blake.mcf), а также 
название программы (MultiTrend). В правой части находятся иконки для 
минимизации/распахивания, а также закрытия окна. 

� Под строкой заголовка находится ниспадающее главное меню. Многие общие функции 
могут быть вызваны через данное меню. Ниже находятся три вкладки для выбора вида 
отображения. Поэтому эта часть главного окна называется окном Сводных данных. Оно 
используется для того, чтобы можно было выбирать способ представления 
конфигурационных данных. Представлены следующие  варианты : 

- General View (Общий вид). Отображает информацию по расположению 
датчиков относительно более крупных объектов (Рисунок 22 Общий вид) 

- Instrument View (Вид измерительной аппаратуры). Отображает информацию о 
взаимодействии ПО MultiTrend с датчиками. (Рисунок 33 Окно Instrument View) 

- Status View (Окно статуса). Отображает текущее состояние датчиков. (Рисунок 
44 Окно статуса) 

� Справа от окна Сводных данных представлено окно Подробной информации. В данном 
окне отображается подробная информация о выбранном в Сводном окне элементе. 

� Под окном Сводной информации находится окно журнала. В нем отображаются 
информационные сообщения, а также сообщения об ошибках. 
 

 

Окно Подробности. 
Показывает более 
подробную 
информацию в 
выбранном 

Строка заголовка 
Выпадаю
щее 
меню 

Окно сводных 
данных 

Для вызова окна 
Подробности 

в правой части, 
необходимо  

Щелкните правой 
кнопкой 

в данном окне 
для вызова 

контекстного меню. 
Меню содержит 

функции, которые 
можно 

применить к 

Окно 
журнала.Отобража

ет 
различную 

Элементы для изменения размера 
Индикатор режима 

Элемент для изменения размера 



CorrOcean ASA РЕД: 04 
РУКОВОДСТВО ПОЛЬЗОВАТЕЛЯ СИСТЕМЫ MULTITREND Страница:

 11 из125 
Документ №:    4174-16959-I-MU-0003 Дата: 03.10.04 
 

Окно General View 
предназначено 

,главным образом, для 
того, чтобы 
отображать 

иерархическую структуру 

Таким символом 
обозначается 
укрупненный 
объект 

Таким символом 
обозначается 
положение 
конкретного 
измерения внутри 
данного объекта 

 

Для раскрытия 
вложенных элементов 

нажмите значок "плюс". 
Для свертывания 

вложенных элементов 
нажмите "минус" 

Информация с 
каждой точки 
измерений 
сохраняется под 
различными 
значками типов 
датчиков 

Рисунок 22 Окно General View 
 

Окно Instrument View 
предназначено для 

отображения 
измерительных приборов 

а также их подключений 
 

Данным значком 
обозначается 
подводный датчик.Он 
подсоединяется к 
интерфейсу, 
соответствующему 
коммуникационному 
каналу (в данном 
случае Modbus). 
Данные от 
измерительного 
прибора передаются 
в ПО MultiTrend 
посредством данного 
интерфейса и 
сохраняются в 
ячейках 

Значки обозначения 
интерфейсов 

 
показывают, каким 

образом 
измерительные приборы 

физически подключены 
Данные от 

измерительных приборов 
сохраняются 

в ячейках 
Рисунок 33 Окно Instrument View 

 

Рисунок 44 Окно статуса 

5.2      Краткое описание элементов конфигурации ПО MultiTrend 

В программе MultiTrend используется пять классов элементов конфигурации. А именно: 

� Датчики 
Все данные, полученные в результате измерений, сохраняются в ячейках 
соответствующих датчиков. Датчик определяет перевод первоначальных, необработанных 
данных в итоговые данные результата. Все параметры расчета сохраняются вместе с 
датчиком. Для получения доступа к итоговым данным, а также параметрам конкретного 
датчика, нужно выбрать этот датчик в окне Сводной информации. 

� Зоны 
Используется только один тип зон. Он используется для группировки совместно 
расположенных датчиков. 

 

Здесь показано 
состояние 

последней операции 
подключения/ 

расчета 

В окне Status View  
показаны результаты 
последнего 
измерения, также 
состояние системы. 

Дата и время 
последнего успешно 
произведенного 
измерения 

Здесь 
отображаются 
данные 
результатов, 
выбранные на 
закладке "Расчет" 

На закладке 
"Расчет" можно 
выбрать 
единицы 
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Датчики грунта включают в себя датчики из той же зоны, что и входные каналы для 
расчетов по грунту.Значок зоны отображается лишь в окне General View. 

� Системы 
Используется только один тип систем. Используется лишь для группировки элементов в 
окне General View и облегчения поиска конкретного датчика в укрупненных структурах. 

� Измерительные приборы 
Измерительные приборы управляют сбором данных от физических измерительных 
устройств. Измерительные приборы отображаются только в окне Instrument View. 

� Интерфейсы 
Интерфейсы описывают коммуникационные каналы между ПО MultiTrend и физическими 
датчиками. Интерфейсы отображаются только в окне "Измерительные приборы". 

5.2.1 Датчик отбора проб грунта 

Этот датчик обозначается в виде  значка. Он также содержит ряд металлических элементов, 
которые могут разрушаться под воздействием частиц грунта. При этом происходит 
истоньшение этих элементов, их электрическое сопротивление возрастает.Датчик грунта 
измеряет это сопротивление и передает эту информацию в ПО MultiTrend. На основе 
полученных данных, рассчитываются следующие величины: 

� Потеря металла 
Изменение толщины подверженного разрушению металла с момента установки нового 
датчика. 

� Интенсивность эрозии 
Скорость, с которой происходит истоньшение металлических элементов. Расчет этого 
показателя основан на средней величине изменения последних значений потери металла. 
Количество значений, используемых для расчета устанавливается кнопкой F>> за полем 
отображения скорости потери металла на вкладке "Расчет" грунтовых датчиков. 

� Интенсивность выноса грунта 
Это расчетное значение выноса грунта за единицу времени. Расчет основывается на 
величине Интенсивности эрозии, скорости движения среды, в которой находится грунт, а 
также среднего размера частиц грунта. Величины скорости движения среды, а также 
размер частиц снимаются с датчиков потока и размера частиц, расположенных в той же 
зоне, что и датчик грунта.. 

� Аккумулированная величина выноса грунта 
Это количество выносного грунта за определенный период времени; по 
данному параметру можно только построить диаграмму. 

� Содержание грунта 
Количество грунта на единицу объема среды. 

5.2.2 Датчик потока 

Датчик потока обозначается значком . Датчик потока сохраняет значении скорости потока 
нефти, воды и газа в трубопроводе, где установлен датчик грунта. Данные значения вводятся 
вручную, если они не были получены от датчика. На основе данных величин рассчитывается 
скорость среды, находящейся в трубопроводе, которая затем используется при расчете 
содержания грунта.Также, в качестве входных данных для расчета используется диаметр 
трубы, величина давления и температуры в исследуемой зоне. 

5.2.3 Датчик размера частиц 

Датчик размера частиц обозначается значком  Он используется для хранения величины 
среднего размера частиц, используемой в расчетах по грунту.Как правило, ввод данных 
осуществляется вручную. 

5.2.4 Датчик давления/температуры 

Датчик давления/температуры обозначается значком .  Он используется для хранения 
величин давления и температуры (полученных от датчиков, или введенных вручную при их 
отсутствии). Значения давления и температуры используются для расчетов по грунту и 
скорости потока среды датчиками грунта и потока, расположенными в данной зоне. 
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5.2.5  Датчик матрицы FSM 

 Датчик матрицы FSM обозначается значком . В нем сохраняются замеры контактных пар 
матрицы FSM. 

5.3      Система состояния MultiTrend 

В системе MultiTrend имеется подсистема, предоставляющая информацию о состоянии 
всех элементов конфигурации (Измерительных приборов, датчиков, интерфейсов); каждый 
элемент конфигурации может иметь несколько состояний, которые с помощью данной 
подсистемы отображаются, а также могут быть экспортированы: 
В окне General View, а также  Instrument View состояние отображается в виде желтой или 
красной точки рядом со значком элемента. Красный цвет соответствует сигналу тревоги, 
желтый - предупреждения. 

Подробная информация о предупреждающих сигналах приводится в окне информации для 
конкретного элемента, Рисунок 55. 

 

Рисунок 55 Окно информации о состоянии 

В окне Подробной информации, данные о состоянии, текущей активности, а также дате и 
времени последнего изменения состояния объекта, отражены в трех текстовых полях. Для 
получения более подробной информации по данному сигналу тревоги, щелкните 

значок статуса  или 

В окне аварийного сигнала, Рисунок 66, приводится следующее: 
� Древовидная структура, отражающая вовлеченные элементы 
� Описание аварийного сигнала с объяснением и зафиксированным временем 

возникновения 
�  В целях проверки, при помощи впадающего списка, можно вручную активировать 

те или иные аварийные сигналы. 
� Кнопки снятия аварийного сигнала 

 

 
Рисунок 66 Окно аварийного сигнала 
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5.3.1 Типы состояний 

� Контрольная проверка. Итоговый результат расчета сравнивается с набором 
предельных значений, определяемых пользователем. 
(Опционально): 

o Превышение ( Последний итоговый результат превышает предельное 
значение) 
o  Низкий показатель (Последний итоговый результат ниже  предельного 
значения) 

o Превышение в течение периода (Последний итоговый результат превышал предельное 
значение в течение определенного периода времени) 

o  Низкий показатель в течение периода ( Последний итоговый результат был ниже 
предельного значения в течение определенного периода времени) 

o  Не обновлялся в течение периода ( Последний итоговый результат не 
обновлялся в течение определенного периода времени) 
o  Не менялся в течение периода ( Последний итоговый результат не менялся 
в течение определенного периода времени)  

� Измерение. Информация о любых ошибках, передаваемая физическими 
приборами в отношении электроники или датчиков. Определяется для каждого 
типа измерительных приборов. 
 Примеры: 

o Отказ элемента (указывает на узел датчика) 
o Низкий заряд батареи 
o Потеря питания 
o Открытая пара - указывает на узел матрицы 

� Состояние коммуникации. Результат последней сессии коммуникации 
o    Код ошибки 

� Неопределенное состояние. Когда ПО MultiTrend переходит в рабочий режим, 
состояние измерительных приборов должно устанавливаться в положение 
"неопределено". Соответственно, все остальные аварийные сигналы снимаются и 
устанавливается аварийный сигнал типа "не определен". Такой тип аварийного 
сигнала снимается при первом возникновении реального аварийного сигнала для 
какого-либо элемента (например при установке коммуникационных сессий, 
проведении измерений..). 

� Состояние  активности/прогресса. 
o    Соответствует периоду осуществления каких-либо 
действий, обычно - прогрессу коммуникационной сессии. o    По 
завершении всегда деактивируется. 

5.3.2 Правила расстановки статуса для элементов  

Основным принципом является то, что для укрупненных элементов отражается совокупное 
состояние входящих в них подузлов. Для этого, виды статуса должны распределяться между 
элементами. 

Установка статуса в окне Instrument View происходит от корневых элементов к подчиненным, а 
в окне General View - наоборот. Для укрупненного элемента всегда отображается "худшее" 
состояние его подузлов. В окне  
Instrument View всегда отображается "худшее" состояние вышерасположенных по иерархии 
элементов. 

5.3.3 Аварийные и предупреждающие сигналы 

Каждому датчику, измерительному прибору и системе в ПО MultiTrend соответствуют 
определенные аварийные сигналы. Сигнал содержит информацию о превышающих 
предельное значение результатах измерений, отказах приборов, проблемах связи с 
устройствами, а также других проблемах.Отдельный сигнал можно выделить для конкретного 
датчика или измерительного прибора; либо, можно сгруппировать сигналы для группы датчиков 
(а также систем, или зон).Сигнал представляет собой 32-битную величину (целое без знака). 
Каждый бит несет определенное значение и рассматривается отдельно. 

 



CorrOcean ASA РЕД: 04 
РУКОВОДСТВО ПОЛЬЗОВАТЕЛЯ СИСТЕМЫ MULTITREND Страница:

 15 из125 
Документ №:    4174-16959-I-MU-0003 Дата: 03.10.04 
 
Номер бита    Название Примечания 
0 A_AboveLimit Устанавливается когда значение замера 

превышает установленный предел. Снимается 
когда значение замера вновь опускается ниже 

1 A_BelowLimit  Устанавливается когда значение замера ниже 
установленного предела. Снимается когда 
значение замера вновь поднимается выше 

2                     A_AboveLimitAlarm Устанавливается когда определенное количество 
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  превышает установленные пределы. 

Снимается когда результат замера вновь 
опускается ниже предельного значения. 

3 A_BelowLimitAlarm  Устанавливается когда определенное 
количество последовательных замеров ниже 
установленной предельной границы 
(нижней).Снимается когда результат замера 

4 A_UpdateTimeOut Устанавливается, если в течение заданного 
временного периода не поступило очередное 
значение замера 

5 A_NoChange Устанавливается, если определенное число 
последовательных замеров идентично 
. 

6 A_LowHardDisk Устанавливается когда на системном диске, либо 
на диске, содержащем БД, осталось менее  10MB 
, либо менее 15% свободного места. 

7 A_FileError Устанавливается при возникновении 
ошибки записи в файл экспорта данных. 
Снимается после успешной записи в 

8 A_AllElementsInvalid Устанавливается, если все элементы не пригодны 
для проведения замера. 
 
Снимается при установке пригодности хотя бы 

9 A_SomeElementsInvalid Устанавливается, если хотя бы один из элементов 
непригоден 
(сопротивление элемента вне диапазона 0.1мОм -  
1.0 Ом, либо потеря металла элемента менее –
10% или более 70%  
толщины элемента 
) 

10 A_SandCalc_FlowTooLow Устанавливается, если скорость потока слишком 
низка 
для проведения замеров по грунту. 
Снимается, когда скорость потока достаточна 
для замеров по грунту 
(Применимо к Датчикам грунта (интенсивность 

11 A_InvalidProbeData Устанавливается, если входные данные 
датчика не соответствуют установленному 

12 A_InvalidProbeInputData Устанавливается, если выдаваемые датчиком 
расчетные значения непригодны для 
использования в последующих вычислениях. 

13 A_InvalidTimestamp Устанавливается, если получен замер с неверно 
указанной временной отметкой . 
Снимается, когда получен замер с верной 
временной меткой. 

14 A_RetrieveFailure Устанавливается при возникновении ошибки в 
получении 
замеров от измерительного прибора (ручным 
способом или по расписанию) 
 

15 A_NoResponseFromInstrument Устанавливается, если на последнюю команду, 
данную измерительному прибору, не было 
получено ответа. 
 

16 A_InstrumentReceivedIllegalCo 
mmand 

Устанавливается при получении от 
измерительного прибора сообщения о проходе 
недопустимой команды.Снимается после 
корректного прохода команды на измерительный 

17 A_InvalidResponseFromInstrum 
ent 

Устанавливается, если от измерительного 
прибора получен неприемлемый ответ. 
Снимается при получении приемлемого ответа 
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18 A_InvalidInstrumentData Устанавливается, если информационный пакет 

замеров, полученный от измерительного прибора, 
имеет неверный формат, 
либо неверную контрольную сумму. 
 

19 A_ConnectionProblem Устанавливается, если измерительному прибору 
или интерфейсу не удалось открыть 
коммуникационный порт. Снимается при 
корректном открытии коммуникационного порта. 

20 A_NoResponseFromFieldBusM 
aster 

Устанавливается, если не отвечает Блок 
рабочей зоны. Снимается при получении 

21 A_CommunicationProblem Устанавливается при возникновении проблемы 
связи общего типа 
. 

22 A EmergencyMode Регистрирующее устройство в аварийном режиме  
23 A_LowMemory Устанавливается, когда система MultiTrend 

фиксирует низкий уровень доступной памяти 
24 A_DatabaseError Устанавливается, если системе  MultiTrend не 

удается корректно сохранить значение замера в 
25 A_HousekeepingWarning Устанавливается для узла измерительного 

прибора при активации 
26 A_ HousekeepingAlarm Устанавливается для узла измерительного 

прибора при активации аварийного сообщения для 
27-30 Зарезервировано для Зарезервировано для перспективного 
31 A_Unknown Устанавливается для всех элементов при 

запуске MultiTrend в рабочем режиме. Например, 
это происходит после неуправляемого 
выключения ПК, или изменений в конфигурации. 
Состояние датчиков устанавливается в 
положение "неопределено" до момента 
поступления новых данных или возникновения 

5.3.4   Отслеживание. Установка предельных значений. 

Система MultiTrend может быть настроен так, чтобы отслеживать все поступающие данные 
и активировать предупреждающие и аварийные сигналы при определенных условиях. 

Для того, чтобы открыть окно отслеживания для конкретного сигнала, нажмите кнопку  M>> , 
как показано на рисунке. 

 
Рисунок 77 Открытие окна отслеживания 

В окне отслеживания (Рисунок 88) можно указать верхние и нижние пределы для выбранного 
сигнала. Если значение сигнала находится за рамками заданного диапазона, для данного 
датчика будет активировано предупреждение о выходе значения за пределы. Если за 
пределами допустимого диапазона находится ряд последовательных значений, для данного 
датчика будет активирован аварийный сигнал о выходе значения за пределы. 
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Рисунок 88 Окно настройки отслеживания 

Настройка отслеживания позволяет сделать так, чтобы активация аварийного сигнала 
происходила, если какое-то значение не меняется в течение определенных временных 
интервалов. 

Нажатие на кнопку "Apply to All" (Применить ко всем), скопирует данные настройки для всех 
сигналов того же типа, относящихся ко всем датчикам этого типа. 

5.4      Использование ПО MultiTrend совместно с прибором MultiCorr 

MultiCorr является, возможно, наиболее гибким в использовании и продвинутым ручным 
прибором измерения степени коррозии.Он предназначен для прямого взаимодействия со 
всеми типами датчиков коррозии, но также, может поставляться в виде автономного устройства 
сбора данных для продолжительного отслеживания коррозии. Также он может подключаться к 
регистрирующим устройствам, поставляемым CorrOcean. Более подробную информацию по 
использованию данного измерительного прибора см. в  соответствующем руководстве. 

Управление прибором осуществляется при помощи соответствующего программного 
обеспечения - снятие показаний датчиков производится с помощью простых команд 
оператора.Показатели отображаются сразу же, например, в мм, тысячных долях дюйма 
(совокупная потеря металла), мм/г или тдд/г (интенсивность коррозии), мА и мВ 
(гальванический ток или потенциал) - по выбору оператора. Показатели сохраняются в памяти 
большой емкости, вместе с идентификаторами датчиков, отметками даты и времени, и, в 
дальнейшем могут быть выведены в любой момент. 

Прибор может применяться с любыми типами датчиков (ER, LPR или Гальваническими) - путем 
простого выбора типа датчика  в меню и указания площади поверхности электрода (для 
датчиков типа LPR или Гальванических) или толщины считывающего элемента (для датчиков 
типа ER) . К тому же, данный измерительный прибор может считывать значения 
потенциала/напряжения, и, таким образом, использоваться для измерения тока на выходе 
шунтированных анодов, а также потенциала контрольного электрода в катодной защите. 

Прибор MultiCorr, в памяти которого находятся показатели замеров за день, за неделю, или 
месяц, можно напрямую подключить к ПК. Система  же MultiTrend  способна считывать эти 
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данные, и кроме того, она предоставляет удобный инструментарий для работы с ними. 
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5.4.1   Создание конфигурации MultiTrend 

Для создания чистого конфигурационного файла, выберите пункт меню File->New. Укажите 
подходящее имя файла, например "MultiCorr Test", так, чтобы его потом легко можно было 
найти. 

5.4.1.1 Подсоединение прибора MultiCorr к системе MultiTrend. 

Прибор MultiCorr подключается только посредством COM-порта. 

5.4.1.2 Создание интерфейса 
Выберите пункт меню  Edit->New->Interface , как показано на Рисунке 11 (или New->Interface из 
контекстного меню). 

 
Рисунок 99.  
Создание интерфейса 

Открывается окно выбора интерфейса, показанное на Рисунке 1010. Выберите Serial 
(Последовательный), и нажмите кнопку Next> . 

 

Выберите нужный 
тип интерфейса 

Нажмите  
Next для 
продолжения 

Рисунок 1010 Окно выбора интерфейса 
 

Если используемый 
вами 

последовательный 
порт 

не указан в списке, 
можно ввести его 

вручную 

Нажмите кнопку 
Finish для 
завершения 
создания 
интерфейса 

Рисунок 1111 Окно выбора порта 

Теперь в окне Instrument View содержится значок, соответствующий новому 
последовательному интерфейсу (См. Рисунок 2424) Выберите значок и выберите вкладку 
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Настройка (Setup) в окне информации.Руководствуясь документацией MultiCorr, выберите 
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скорость передачи данных; либо, проверьте уже установленную скорость передачи. В 
большинстве случаев, для остальных параметров можно оставить значения по умолчанию. 

5.4.1.3  Добавление измерительного прибора MultiCorr 
Для проведения замеров, к интерфейсу необходимо подсоединить измерительный прибор с 
датчиками. 
Выберите пункт контекстного меню интерфейса New->Instrument, укажите название прибора 
(например MC1), 
и, затем выберите MultiCorr из выпадающего списка указания Типа. 

 
Рисунок 1212 Добавление измерительного прибора  

Если прибор уже подсоединен к ПК, с ним уже возможно взаимодействие. 

5.4.1.4  Добавление датчика в конфигурацию MultiCorr 

Для того, чтобы добавить датчик, выберите пункт меню 
Edit->New->Probe,  выберите New->Probe из  

контекстного меню, либо выберите значок на панели инструментов ). 
В данном примере мы добавим датчик типа ER. 

 
Рисунок 1313 Открытие окна выбора датчика 

Откроется окно выбора датчика, как показано на Рисунке 4242. 
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Рисунок 1414 Окно выбора датчика 

5.4.1.5  Установка параметров датчика типа ER 
Для определения числа элементов, а также контрольной толщины используемого вами датчика 
типа ER, необходимо обратиться к документации по датчику. Введите эту информацию в окне, 
как показано ниже, и далее нажмите кнопку Next. В следующем окне вам предлагается ввести 
дополнительную информацию о датчике.Эти параметры указываются по желанию. 

 
Рисунок 1515 Установка параметров датчика типа ER 

Введите данные вашего датчика ER-типа в окне параметров датчика. Если используемый вами 
тип датчика отсутствует, укажите Общий тип датчика. Затем нажмите кнопку Next>. В 
следующем окне вам предлагается ввести дополнительную информацию о датчике. Эти 
параметры указываются по желанию. 

5.4.2   Передача данных от прибора MultiCorr в систему MultiTrend 

Предварительно следует удостовериться, что настройки COM-порта верны. Перейдите в окно 
Instrument View и выберите прибор, от которого вы бы хотели получить данные, установив на 
него курсор. В данном случае, должно быть указано, что прибор MultiCorr подсоединен к 
соответствующему COM-порту. 

Выберите команду Retrieve Data>> на закладке команд в окне Подробной информации об 
измерительном приборе. 
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Рисунок 1717 Получение данных от прибора MultiCorr (2) 

Убедитесь, что выбраны  нужные датчики ( напротив датчиков необходимо поставить галочки). 

Опции, касающиеся сохранения информации датчиками, выбираются при 
установки галочек в соответствующих полях. Для прибора MultiCorr выберите: 

� Advanced mode ( Расширенный режим) 
� Transmit (Передача) 
� Transmit (Передача) 

Начнется передача данных в ПК. 

Если датчик установлен в измерительном приборе, но не был создан в системе MultiTrend 
перед началом передачи данных, программа может создать его автоматически. 

Перед тем, как закрыть окно Передачи данных, полученную информацию необходимо 
сохранить или отклонить.Функция Select/ Deselect (Выбрать/отменить) позволяет 
отфильтровать и сохранить только требуемые данные. Если, например, с прибора MultiCorr 
была получена информация по 10 разным датчикам, а интерес представляет лишь один, то 
перед нажатием кнопки Store Selected (сохранить выбранное), нужно выбрать именно этот 
датчик. Будет сохранена информация только с выбранного датчика. 

Примечание 
Для автоматически созданных датчиков, параметры будут заданы по-умолчанию.  Эти 
значения необходимо изменить, с тем, чтобы они соответствовали фактическим параметрам 
датчиков. 

 
Рисунок 1616 Получение данных от прибора MultiCorr (1) 
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5.4.3   Передача конфигурационной информации системы MultiTrend в прибор MultiCorr 

Настроечная информация датчика содержит такие элементы, как идентификационные номера, 
начальную величину толщины датчика, тип датчика и т.д. Эту информацию нужно указать и для 
прибора MultiCorr, чтобы его можно было полноценно использовать. Ввод данных можно 
осуществить вручную, либо путем передачи из системы MultiTrend. 

Для передачи данных из системы MultiTrend, необходимо подсоединить MultiCorr к ПК и 
удостовериться, что настройки COM-порта верны. В данном случае, должно быть указано, что 
прибор MultiCorr подсоединен к соответствующему COM-порту. 

Затем, откройте окно Instrument View и выберите прибор, в который нужно передать данные. 
Выберите вкладку Commands (Команды) и нажмите кнопку Transmit Probes>>. 

 
Рисунок 1818 Передача параметров датчиков в MultiCorr (1) 

Напротив нужных датчиков поставьте галочки. 

 
Рисунок 1919 Передача параметров датчиков в MultiCorr (2) 

В приборе MultiCorr: 

� На MultiCorr MKI выберите: 
- Advanced mode (Расширенный режим) 
- Acq. Setup (Настройка загрузки) 
- Inst/Edit Tag (Уст./Ред. идентификатор) 
- Введите код прибора 
- Rec. From PC (Получение от ПК) 

� На MultiCorr MKII выберите: 
- Advanced mode (Расширенный режим) 
- Acq. Setup Настройка 
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-     Load from PC (Загрузка с ПК) 

В программе MultiTrend ответьте ОК - для запуска процесса передачи параметров датчиков в  

MultiCorr. 

Примечание 

При передаче данных, последовательность идентификационных номеров/номеров каналов 
определяется номером датчика, указанном в поле Address в диалоговом окне MultiCorr.   Все 
номера датчика 
для датчиков одного типа должны быть уникальными. Датчику, для которого указан адресный 
номер 5, будет присвоен этот же 
номер канала в приборе MultiCorr. Нумерация датчиков начинается с 0 для каждого датчика 
 

Рисунок 2020 На закладке Address показаны номера датчиков 

Таким образом, перед повторной передачей данных о датчиках в MultiCorr, уже содержащий 
идентификационные номера, нужно соблюдать следующие меры предосторожности. 

� Убедитесь, что все значения замеров в MultiCorr очищены 
� Обязательно нужно передавать данные по всем датчикам единого типа в систему 
MultiCorr 

ПРЕДУПРЕЖДЕНИЕ 
Обращаем ваше внимание, что система MultiTrend поддерживает идентификационные номера 
длиной в  20 символов, в то время как MultiCorr - только 10 символов. В MultiTrend нет 
ограничения на длину в 10 символов, поэтому, непосредственно, сам пользователь системы 
должен отслеживать правильность вводимых идентификаторов. 

5.5      Офлайновая система  MultiLog/SandLog в MultiTrend  

В данном разделе описывается офлайновая часть системы MultiTrend. 
В системе MultiLog/Sandlog , прибор MultiCorr может использоваться для переноса данных 
замеров от 
регистрирующих приборов в ПК, на котором запущена система MultiTrend. В этом случае, 
MultiCorr используется в терминальном режиме. 

 

При выборе MultiCorr в окне Instrument 
View, в окне подробной информации 
отображается информация о нем. 

Номер датчика используется 
прибором MultiCorr для его 
идентификации после 
завершение передачи 
параметров датчика. 

1-й датчик типа 
LPR соответствует 
позиции датчика 0 

Щелкнув здесь, можно указать номер 
датчика от 0 до 99 1-й датчик типа 

ER соответствует 
типу датчика 
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Данные сбрасываются из регистрирующего устройства в терминал MultiCorr, и, затем 
передаются в систему MultiTrend. 
Данная процедура во многом идентична и для устройства MultiLog и для  SandLog – различие 
заключается в 
разных типах датчиков, которые могут подсоединяться к каждому из регистраторов. В 
следующем примере взят регистрирующий прибор  
SandLogger и датчик грунта. Настройка регистрирующего устройства выполняется при помощи 
прибора MultiCorr 
, поэтому в отношении данного действия следует обратиться к руководству пользователя по 
MultiCorr. 
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5.5.1   Создание конфигурации MultiTrend 

Для создания чистого конфигурационного файла, выберите пункт меню File->New. Укажите 
подходящее имя файла, например "Log Test", так, чтобы его потом легко можно было найти. 

5.5.1.1  Создание интерфейса 
Выберите пункт меню  Edit->New->Interface , как показано на Рисунке 2121 (или New->Interface 

из контекстного меню). 

 

Рисунок 2121 Создание интерфейса 

Появится окно выбора интерфейса, показанное на Рисунке 2222. Выберите 
последовательный (serial) и нажмите кнопку Next> . 

 

Выберите нужный 
тип интерфейса 

Нажмите  
Next для 
продолжения 

Рисунок 2222 Окно выбора интерфейса 



CorrOcean ASA РЕД: 04 
РУКОВОДСТВО ПОЛЬЗОВАТЕЛЯ СИСТЕМЫ MULTITREND Страница:

 29 из125 
Документ №:    4174-16959-I-MU-0003 Дата: 03.10.04 
 

Если 
используемый 
вами 
последовательный 
порт 
не указан в списке, 
можно ввести его 
вручную 

Нажмите кнопку 
Finish для 
завершения 
создания 
интерфейса 

Рисунок 2323 Окно выбора порта  

Теперь в окне Instrument View содержится значок, соответствующий новому 
последовательному интерфейсу (См. Рисунок 2424) Выберите значок и выберите вкладку 
Настройка (Setup) в окне информации. Выберите скорость передачи данных, руководствуясь 
документацией измерительного прибора. В большинстве случаев, для остальных параметров 
можно оставить значения по умолчанию. 

 

Выберите новый 
интерфейс 

чтобы открыть 
окно с подробной 

информацией 

Выберите вкладку 
настроек (setup), 
чтобы открыть 
настройки 
последовательно
го порта 

Руководствуясь 
документацией 
датчика, 
выберите 
скорость 
передачи 
данных 

Рисунок 2424 Установка свойств последовательного порта 

5.5.2   Подключение терминала MultiCorr к системе   MultiTrend 

В контекстном меню интерфейса последовательного порта, выберите  New->Interface. 
В качестве типа интерфейса выберите  Terminal (интерфейсы CorrOcean), как показано на 

 
Рисунок 2525 Создание интерфейса терминала MultiCorr 
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Рисунке 2525. 
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Укажите соответствующее имя 
терминального интерфейса. 
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5.5.3   Добавление прибора-регистратора вручную 

Из контекстного меню интерфейса Терминала, выберите  New->Instrument 
Выберите нужный прибор. В данном примере, мы выбираем SandLog. В поле Tag 
(Идентификатор) укажите подходящее 
название для прибора. 

 

Рисунок 2626 Добавление измерительного прибора 

5.5.3.1  Добавление датчика в конфигурацию MultiTrend 
Для того, чтобы добавить датчик, выберите пункт меню 
Edit->New->Probe (или выберите New->Probe из 

контекстного меню, либо выберите значок на панели инструментов ). В данном примере мы 
добавляем датчик грунта, см. 
Рисунок 2727. 

 

Рисунок 2727 Добавление 
датчика грунта 

Введите подходящее название 
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5.5.3.2  Настройка параметров датчика грунта 
Для определения количества элементов и контрольной толщины вашего датчика грунта, 
обратитесь к документации по датчику. Введите эти данные в окне, как показано ниже, и 
нажмите кнопку Next>. В следующем окне вам предлагается ввести дополнительную 
информацию о датчике. Эти параметры указываются по желанию. См. рисунок 2828. 

 

Рисунок 2828 Настройка датчика грунта 

5.5.3.3  Офлайновая система анализа грунта 
Настройка офлайновой системы анализа грунта показана на Рисунке 2929. 

 
Рисунок 2929 Офлайновая система 

5.5.4   Автоматическое создание регистрирующего устройства и датчиков 

Если в терминале не были определены ни датчики, ни регистратор MultiLog, то система 
MultiTrend самостоятельно создаст необходимые датчики и присоединит их к терминалу 
MultiCorr при поступлении данных, как описано в разделе 5.5.5. Пользователь должен указать 
индивидуальный идентификатор для каждого датчика. Интерфейс терминала MultiCorr перед 
получением данных создается вручную. 
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5.5.5   Получение данных от терминала MultiCorr 

Выберите значок нового терминала MultiCorr; на панели Подробной информации (Detail) 
выберите вкладку Commands (Команды) и нажмите кнопку Retrieve Measurements>>. После 
создания датчиков, появится диалог Получения данных от терминала. 

 
Рисунок 3030 Получение данных от терминала  

Выберите датчики, с которых необходимо снять данные (1), и 
нажмите кнопку Store Selected (2). Данные регистратора будут 
загружены с терминала MultiCorr. 

5.6      Онлайновая система  MultiLog/SandLog в MultiTrend 

В данном разделе описывается настройка онлайновой системы MultiTrend с помощью Блока 
рабочей зоны CorrOcean (FieldBus). Процедура идентична как для системы MultiLog, так и для 
SandLog – различие в основном касается типов датчиков, которые можно подключать к данным 
устройствам. В данном примере мы будем использовать прибор MultiLog и датчик ER-типа 

5.6.1 Создание конфигурационного файла MultiTrend 

Для создания чистого конфигурационного файла, выберите пункт меню File->New. Укажите 
подходящее имя файла, например "FieldBus Test", так, чтобы его потом легко можно было 
найти. 

5.6.2 Подсоединение системы FieldBus к ПК 

Данный шаг определяется типом интерфейса, используемого системой FieldBus. Перед 
продолжением, сверьтесь с документацией головного устройства системы FieldBus 
. 
В данном примере подразумевается, что взаимодействие с ПК осуществляется через 
COM-порт. Устройство MultiLog и датчик подсоединяются к головному модулю FieldBus. 
Приводится и краткое описание по установке интерфейса Modbus. 

5.6.2.1  Добавление интерфейса последовательного соединения 
Для подключения через COM-порт, система MultiTrend должна быть настроена на 
последовательный интерфейс взаимодействия. Выберите пункт меню  Edit->New->Interface , 
как показано на Рисунке 3131 (или New->Interface из контекстного меню). Если датчик снабжен 
интерфейсом Modbus, обратитесь к разделу 5.6.2.2. 
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Рисунок 3131 Создание интерфейса 

Появится окно выбора интерфейса, показанное на Рисунке 3232. Выберите последовательный 
(serial) и нажмите кнопку Next> . 

 

Выберите нужный 
тип интерфейса 

Нажмите  
Next для 
продолжения 

Рисунок 3232 Окно выбора интерфейса 
 

Если используемый 
вами 

последовательный 
порт 

не указан в списке, 
можно ввести его 

вручную 

Нажмите кнопку 
Finish для 
завершения 
создания 
интерфейса 

Рисунок 3333 Окно выбора порта 

Теперь в Окне Instrument View содержится значок, соответствующий новому 
последовательному интерфейсу (См. Рисунок 3434). Выберите этот значок и перейдите на 
вкладку настройки в окне Подробной информации. Выберите скорость передачи данных, 
руководствуясь документацией датчика. В большинстве случаев, для остальных параметров 
можно оставить значения по умолчанию. 
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Выберите новый 
интерфейс 

чтобы открыть 
окно с подробной 

информацией 

Выберите вкладку 
настроек (setup), 
чтобы открыть 
настройки 
последовательного 
порта 

Руководствуясь 
документацией 
датчика, 
выберите 
скорость 
передачи данных 

Рисунок 3434 Установка свойств последовательного порта 

5.6.2.2 Добавление интерфейса Modbus 
Если датчик снабжен интерфейсом Modbus, система MultiTrend должна быть сконфигурирована 
для работы с ним. Подробное описание по такой настройке см. в Руководстве Пользователя 
MultiTrend Modbus. Если головной модуль FieldBus оснащен интерфейсом RS232, пропустите 
данный шаг. 

5.6.2.3 Добавление головного модуля FieldBus 
Для того, чтобы добавить головной модуль FieldBus, выберите пункт главного меню  Edit->New-

>Interface  (или в контекстном меню выберите  New->Interface).  Появится окно выбора 
интерфейса, как показано на Рисунке 3535. Выберите головной модуль FieldBus (интерфейсы 
CorrOcean). 

 
Рисунок 3535 Окно выбора интерфейса 

Укажите подходящее название для интерфейса, например FBM1. 
Если головному модулю FieldBus был присвоен корректный идентификатор в комплексной 
системе, мы рекомендуем 
использовать именно его для обозначения данного модуля в системе MultiTrend. 
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5.6.2.4  Добавление сегмента FieldBus к головному модулю 
 К головному модулю нужно добавит сегмент FieldBus. Сегмент Fieldbus - это интерфейсная 
карта, устанавливаемая в головной модуль. Выберите пункт контекстного меню New->Interface, 
затем - сегмент FieldBus (интерфейсы CorrOcean). Для каждой интерфейсной карты 
определяется один сегмент. Окно Instrument View должно выглядеть, как показано на Рисунке 
3636. 

 
Рисунок 3636 Головной модуль и сегмент FielBus 

5.6.3   Добавление прибора-регистратора и датчика 

Для проведения замеров, к системе FieldBus необходимо подсоединить измерительный прибор 
с датчиками. Из контекстного меню сегмента FieldBus выберите пункт New->Instrument, укажите 
название прибора (например ML1), В данном примере мы выбрали MultiLog. 

 
Рисунок 3737 Добавление измерительного прибора 

Если оборудование уже подключено к ПК, с ним уже можно взаимодействовать. 
Для определения адреса регистрирующего устройства, выберите вкладку Address на панели 
Подробной информации (Detail) и укажите адрес 255 (трансляция) (головной модуль 
взаимодействует со всеми подсоединенными регистраторами). Когда режим трансляции 
используется для идентификации регистратора, его можно подключать только в единственном 
количестве. 
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Рисунок 3838 Определение адреса регистратора 

Выберите вкладку Status Details и щелкните кнопку Refresh!, как показано на  Рисунке 3939. 

 

Рисунок 3939 Взаимодействие с регистратором 

Если соединение настроено правильно, регистрирующее устройство будет передавать 
информацию о своем состоянии. 

Адрес регистратора можно получит из строки Версия SW (SW Version) в окне  Status Details, как 
показано на Рисунке 4040. 

 

SW 
Versio
n 

Внут
р. 
диам

Откал
иброва
но 

Адрес Активные 
датчики 

3.08 -
001

CAL -001 -IJKLM 

Рисунок 4040 Идентификатор (ID) и адрес регистратора 

Как вариант, адрес регистратора может быть получен при помощи Интерактивных Команд 
Регистратора, см. раздел 5.6.6. Во избежание возникновения конфликтов с другими 
устройствами, на закладке Address укажите корректный адрес регистратора. Диапазон адресов 
- от 2 до 31. Адрес 1 используется Головным модулем  FieldBus. 

 

Выберите вкладку Status Details 
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5.6.4 Устранение неполадок при связи с регистрирующим устройством 

Причинами отсутствия ответных сигналов в окне состояния регистратора во время 
осуществления процедуры, описанной в разделе  5.6.2, могут быть следующие. 

� В настройке последовательного интерфейса MultiTrend указана неверная скорость 
передачи данных. 
� Неправильно подключен кабель RS232 между регистрирующим устройством и 

головным модулем FieldBus. (Если во время процесса установки связи между ПК и 
головным модулем, на головном модуле мигают два индикатора зеленого цвета, значит 
подключение осуществлено правильно). 

� Разряжена батарея регистратора. Оставьте регистратор подключенным примерно на 
полчаса и повторите попытку. 

Если проверка вышеперечисленных причин не помогла , то, возможно, регистратор 
неисправен.  Свяжитесь с представителем CorrOcean для получения технической поддержки. 

5.6.5 Получение результатов замеров при помощи системы FieldBus / Регистратор 

Данный шаг подразумевает, что Регистратор и интерфейс FieldBus уже добавлены в 
конфигурацию MultiTrend. 

Все результаты замеров, сохраняемые в системе MultiTrend, связываются с конкретными 
датчиками. Перед тем, как сохранять данные регистратора, необходимо добавить 
соответствующие датчики в конфигурацию. 

5.6.5.1  Добавление датчика в конфигурацию MultiTrend 
Для того, чтобы добавить датчик, выберите пункт меню 
Edit->New->Probe (или выберите New->Probe из 

контекстного меню, либо выберите значок на панели инструментов ). 
В данном примере мы добавим датчик типа ER. 

 
Рисунок 4141 Открытие окна выбора датчика 

Откроется окно выбора датчика, как показано на Рисунке 4242. 

 
Рисунок 4242 Окно выбора датчика 
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5.6.5.2  Установка параметров датчика типа ER 
Для определения числа элементов, а также контрольной толщины используемого вами 
датчика, необходимо обратиться к документации по датчику. Введите эти данные в окне, как 
показано ниже, и нажмите кнопку Next>. В следующем окне вам предлагается ввести 
дополнительную информацию о датчике. Эти параметры указываются по желанию. 

 
Рисунок 4343 Установка параметров датчика типа ER 

Для определения типа используемого вами датчика, воспользуйтесь документацией. Введите 
необходимую информацию в окне параметров датчика. Если используемый вами тип датчика 
отсутствует, укажите Общий тип датчика (Только для датчиков ER-Типа). Затем нажмите кнопку 
Next>. В следующем окне вам предлагается ввести дополнительную информацию о датчике. 
Эти параметры указываются по желанию. 

5.6.5.3  Проверка настроек датчика 
После добавления всех датчиков, которые необходимо проверить, окно Instrument View должно 
выглядеть как показано на Рисунке 4444. 

 
Рисунок 4444 Окно Instrument View после добавления регистратора и датчиков 

5.6.5.4  Осуществление единичных замеров 
В системе MultiLog может сохраняться до 3000 буферов, содержащих результаты замеров.    
Максимальное количество замеров зависит от используемого типа датчика. 
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Чтобы убедиться, что результаты измерений находятся в буферах, необходимо настроить 
регистратор так, чтобы он производил замеры через определенные интервалы. 

Для начала, нужно синхронизировать внутренний таймер регистратора с таймером ПК. 
На вкладке Commands, нажмите кнопку Synchronise Now!. 
В окне Instrument View выберите MultiLog, перейдите на вкладку  Commands и нажмите кнопку 
Change 
в группе элементов Measure.В появившемся диалоговом окне можно указать интервал 
осуществления замеров регистратором(См. 
рисунок 4545).   Для проверки, в поле  "Measure Every x [интервал]" укажите значение 2 
минуты. 
Нажмите OK. MultiTrend передаст эти параметры регистратору. 
В окне журнала MultiTrend отображается состояния взаимодействия. 

 
Рисунок 4545 Настройка интервала регистратора 

Для того чтобы убедиться, что регистратор произвел замеры, подождите несколько 
минут перед тем как продолжить. На вкладке Status Details нажмите Refresh и 
проверьте, что величина Used Buffers (Использованные буферы) больше  0. Это 
значит, что в регистраторе содержатся результаты замеров. 

Нажмите кнопку Retrieve Now! на вкладке Commands. Система MultiTrend произведет запрос 
результатов замеров у регистратора. Если в буферах содержится много результатов замеров, 
эта процедура может занять некоторое время. 

 
Рисунок 4646 Получение результатов замеров от регистратора 

На панели Подробной информации датчика будет показан последний результат замера с 
отметкой  о времени его проведения. 
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Рисунок 4747 Полученные результаты замера датчика 

5.6.5.5  Получение результатов замеров в автоматическом режиме 

Как было сказано в предыдущем разделе, систему MultiLog можно настроить так, чтобы она 
производила замеры через определенные интервалы времени.В соответствии с этим режимом 
можно настроить и систему MultiTrend. 

На Рисунке 4848 показана часть панели с рисунка 4747, используемая для настройки 
автоматического приема данных от регистратора. 

 

Рисунок 4848 Настройка автоматического приема данных 

Укажите требуемый интервал, значение для поля Next Retrieval (Следующий прием данных), 
если это необходимо, а также установите переключатель приема в положение ON (ВКЛ). 
Значение, установленное в поле Next Retrieval - задержка перед первым автоматическим 
считыванием данных. (т.е. она может составлять до  24 часов!) Из меню Mode (Режим), 
выберите   Online, чтобы включить онлайновый режим. Автоматический прием данных будет 
работать только в этом режиме. 

 
Рисунок 4949 Вход в онлайновый режим 

Через указанный промежуток времени,  MultiTrend соединится с регистратором и загрузит все 
находящиеся в буферной памяти результаты замеров. 
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5.6.6   Расширенная настройка регистратора 

Для осуществления расширенной настройки регистратора, нажмите кнопку Advanced Setup>> 

на вкладке Commands, Рисунок 4646. 
Откроется диалоговое окно расширенной настройки регистратора, Рисунок 5050. 
Наиболее часто используемые команды -  Clear Logger Memory After Retrieval (1) (Очистка 
памяти регистратора после передачи данных) и 
Stop Retrieval After Failed Reset (2) (Останавливать передачу при аварийном перезапуске). 

(1) Производит очистку всех буферов регистратора после передачи данных. Если этот 
пункт не отмечен галочкой, через определенный период времени буферы регистратора 
заполнятся. Соответственно, регистрация новых данных замеров будет прекращена. 

(2) Если этот пункт отмечен галочкой, то при при перезагрузке ПО, автоматически будет 
остановлена и передача данных от регистратора. 

 

Рисунок 5050 Расширенная настройка регистратора 

Нажав на кнопку Logger Configuration>> на вкладке Commands, можно получить 
доступ к еще одному набору настроек интерактивных команд регистратора, 
Рисунок 4646. Эти команды перечислены на Рисунке 5151. 

 

Рисунок 5151 Интерактивные команды регистратора 

5.7       
 Порядок эксплуатации системы контроля Коррозии/Воздействия грунта (в 
Надстройке)  

В данном разделе описывается типовой порядок эксплуатации системы контроля 
Коррозии/Воздействия грунта (в Надстройке)   
. 
В данном примере подразумевается, что пользователь уже обладает определенными 
знаниями по настройке взаимодействия 
и датчиков в системе MultiTrend. 

5.7.1   Конфигурация 

В качестве примера, мы используем комбинированный датчик Грунта/ER, подключенный к 
регистратору SandLog, соединенному с ПК посредством системы FieldBus и 
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Com-порта. 
Для получения более подробной информации по настройке системы FieldBus, см. раздел 5.6. 
Офлайновые датчики потока, размера частиц и pT используются для ввода данных, 
применяемых при расчетах. 
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Примечание 
Для того, чтобы датчик потока, размера частиц и датчик-pT, работали в качестве источников 
входных данных для расчетов, они должны быть физически размещены в той же зоне, что и  
датчики, для которых осуществляется расчет. 

На рисунке 5252 показано физическое расположение различных датчиков в окне General View. 
Все датчики должны 
быть расположены в одной зоне (Loc1).   На самом же деле, в зоне Loc1 физически расположен 
только Комбинированный датчик 
, остальные же являются виртуальными, офлайновыми, они используются только в качестве 
входных значений для расчетов. 
 
Комбинированный датчик показан как два раздельных датчика: один - ER-типа и один - датчик 
грунта. 

 
Рисунок 5252 Окно General View 

На рисунке 5353 показано логическое соединение датчиков в окне Instrument View. 
Справа показаны датчики, подсоединенные к регистратору. 
Обратите внимание, что поле Connector идентично как для Sn1 , так и для Er1, - что означает, 
что это комбинированный 
датчик Грунта/ER. 

 

Рисунок 5353 Окно Instrument View 
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На Рисунке 5454 показано окно состояния датчика.    Обычно это окно используется при 
функционировании системы  MultiTrend в режиме онлайн. 

 
Рисунок 5454 Окно статуса 

Для отображения значений датчика в окне статуса датчика (Probe Status View), отметьте 
галочкой поле соответствующего значения в окне Calculations датчика, как показано на Рисунке 
5555. 

 

Рисунок 5555 Отображение значений датчика в окне Status View 

Чтобы включить упрощенный вид, нажмите кнопку  Simple View на панели инструментов, как 
показано на Рисунке 5656. 

 

Рисунок 5656 Выбор упрощенного вида 

Теперь система MultiTrend будет автоматически получать результаты замеров 
через установленные промежутки времени. Значения выбранных датчиков 
отображаются в окне Probe Status View, как показано на Рисунке 5757. 

 
Рисунок 5757 Просмотр результатов замеров датчика 

 

 Кнопка Simple View (Упрощенный вид) 
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5.8      Использование ПО MultiTrend с подводными датчиками CorrOcean 

В данной главе описывается повседневная эксплуатация  контрольной системы подводного 
грунта/коррозии CorrOcean. 

5.8.1   Общее описание системы 

Типовая система содержит следующие элементы: 

� Подводные датчики грунта CorrOcean 
Датчик состоит из блока формирования электросигнала, а также интрузионного датчика 
грунта.. Блок монтируется на трубе, как показано на Рисунке 5858. 

� Подводные модули управления/ Подводный электронный модуль 
Каждый из датчиков грунта подсоединяется к модулю управления. Питание на датчик 
грунта также подается от модуля управления. К тому же, он обеспечивает 
взаимодействие датчика грунта и системы управления /DCS. 

� Система управления / DCS 
Взаимодействует с подводными модулям управления /SEMs. Она принимает "сырые" 
данные замеров от датчиков грунта и направляет их в устройство расчетов по грунту. 

� Устройство расчетов по грунту  
Принимает от системы управления "сырые" данные датчик грунта, рассчитывает 
инженерные параметры и перенаправляет их снова в систему управления. 

 

Рисунок 5858 Типовая система подводных датчиков 
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Компьютерный блок обработки данных по грунту содержит следующие программные 
компоненты: 

.    Программное обеспечение CorrOcean MultiTrend 
Это основной программный пакет, куда поступают необработанные данные замеров, и 
где происходит расчет инженерных показателей, а также сохранение результатов 
замеров.В системе MultiTrend имеются функции отображения, вывода диаграмм, а 
также распечатки результатов замеров. 

.    Конфигурационный файл  MultiTrend 
В данном файле содержатся все необходимые данные, используемые системой  
MultiTrend для обработки результатов замеров, поступающих от датчиков.Сюда входят: 
идентификаторы, типы датчиков, параметры расчетов, информация по 
коммуникационным интерфейсам. 

.    Файл базы данных MultiTrend 
В данном файле содержатся все сохраненные результаты замеров. 

.     Модули интерфейса 
Конкретные модули интерфейса могут различаться в различных системах, однако, тем 
не менее, их основное предназначение - получение необработанных данных от 
системы управления и выдача обработанных данных. Основными являются: Модули 
интерфейса Modbus  (MTModbus и CorrMod в системах вплоть до версии 2.26 и 
RegSigMap и CorrMod в более поздних версиях системы), Интерфейсный модуль STP  
(STPInterface), Интерфейсный модуль SQL (SQLInterface) и Интерфейсный модуль OPC 
(OPCInterface) 

.     Файлы конфигурации интерфейса 
Конфигурационные файлы интерфейсных модулей. 

5.8.2   Пример системы 

В нижеприведенных разделах описывается типовая система контроля грунта. 

5.8.2.1   Конфигурация MultiTrend 

В окне General View показано три шаблона: L, M и N. Здесь же приводятся по 4 зоны замеров 
для каждого 
шаблона, а также группы датчиков в каждой из зон. Фактическими датчиками являются только 

датчик грунта и датчик давления/температуры  
. Датчик потока и датчик размера частиц - виртуальные датчики, используемые только как 

источники входных данных для осуществления расчетов по грунту . На рисунке 5959 
показаны: окно General view слева и окно Instrument view справа. 
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Рисунок 5959 Образец конфигурации MultiTrend 
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5.8.2.2  Интерфейс Modbus 
Интерфейсный модуль  
Modbus состоит из двух специальных программ, работающих в компьютерном блоке обработки 
данных по грунту. Это: программа CorrMod, управляющая связью по каналу Modbus, а также 
программа RegSigMap, передающая данные по каналу Modbus в систему MultiTrend и 
наоборот. 

Примечание 
В версии системы MultiTrend 2.26 и старше, RegSigMap называется MTModbus, и, кроме того, 
пользовательские интерфейсы MTModbus и CorrMod несколько отличались от тех, что 
используются в текущих версиях системы. 

Если MultiTrend запускается в режиме работы через Modbus, то автоматически запускается и 
программа RegSigMap, которая, в свою очередь, запускает программу CorrMod. 

На рисунке  6161 показана программа RegSigMap. Эта программа должна быть активна, чтобы 
система MultiTrend могла работать через интерфейс Modbus. 

Программа CorrMod отображается в системной области (небольшая зона в нижней правой 
части экрана) в виде мигающего красно-сине-зеленого значка: 

 
Рисунок 6060 Значок CorrMod в системной области 

Для доступа к интерфейсу программы CorrMod, необходимо дважды щелкнуть данный значок,  
Рисунок 6262. 

 
Рисунок 6161 Пользовательский интерфейс RegSigMap 

 
Рисунок 6262 Пользовательский интерфейс программы CorrMod 
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5.8.3   Эксплуатация системы 

Нормальным режимом функционирования системы является автоматический режим.Далее 
приводятся основные задачи оператора системы. 

5.8.3.1  Ручной ввод рабочих параметров 
Интенсивность потока грунта, величина накопления грунта, а также его содержание - все это 
показатели, зависящие от давления, температуры, скорости потока, среднего размера частиц 
грунта и диаметра трубы на участке размещения датчиков. Эти параметры нужно вводить 
вручную, причем каждый раз, когда они меняются более чем на  10-20%. Если этого не делать, 
расчеты по грунту будут неверными. 

На рисунках  
6363 и  6464 показано, как осуществляется ручной ввод значений. Значения Давления и 
Температуры не следует менять до получения результатов замеров от соответствующих 
датчиков. 
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1) 
Диаметр трубы  
(внутренний) - 
неизменная 
величина.. 

 3) 
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Input 
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Рисунок 6363 Ручной ввод рабочих параметров (1) 
 

Рисунок 6464 Ручной ввод рабочих параметров (2) 

5.8.3.2  Проверка работоспособности системы 
В некоторых системах предусмотрены механизмы аварийного оповещения, связанные с 
временными отметками осуществляемых замеров. Если временные отметки перестают 
обновляться, включается аварийный сигнал. Это значит, что что-то работает неправильно. 

Если система управления не оснащена такой аварийно системой, то наиболее простой путь 
проверить работоспособность системы - удостовериться, что поступающие в систему значения 
показателей меняются.Всегда имеются небольшие помехи при замерах, поэтому хотя бы в 
небольшой степени, но показатели должны различаться при каждом замере. 
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Такая же проверка может быть проведена в системе MultiTrend, как показано на  Рисунке 6565. 

Рисунок 6565 Проверка работоспособности системы 

Следует проверить работоспособность интерфейса Modbus. 
Включите режим редактирования (Edit Mode) в программе CorrMod, и выберите значок 
Управляющего модуля (Master). Затем выберите раздел "свойства" (properties) и включите 
запись в журнал (logging). Закройте окно "свойства" и выберите вкладку "журнал" (log). Теперь 
должны быть видны сообщения Modbus, поступающие через головной модуль Modbus. 

5.8.3.3  Копирование файла с БД для анализа в оффлайновом режиме 
Зачастую, полезно извлекать данные для дальнейшего анализа в оффлайновом режиме. Это 
можно сделать путем копирования конфигурационного файла MultiTrend, а также 
соответствующего файла базы данных. На Рисунке 6666 показано, как найти этот файл. С 
течением времени, файл базы данных может сильно разрастаться, поэтому целесообразно 
использовать специальную программу для сжатия, а также носители информации большой 
емкости. 

См. также пункт 5.11.6 - Экспорт и Импорт данных. 
 

Рисунок 6666 Установление местонахождения файла конфигурации и базы данных 
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5.8.3.4 Перезапуск системы 

Существует два способа перезапуска 

системы: 
� Управляемый останов и перезапуск 
� Перезагрузка и перезапуск 

� Управляемый останов и перезапуск: 
� Закройте все программы. Для того, чтобы это можно было сделать, система MultiTrend 
должна находится в сервисном режиме. 
� Убедитесь, что отсутствуют модули, работающие в фоновом режиме. При помощи 

Диспетчера задач, просмотрите список активных процессов на предмет следующих: 
- MultiTrend, 
- Для систем с интерфейсом Modbus: MTModbus и CorrMod или RegSigMap - для 

систем, начиная с версии 2.27 
- Для систем с интерфейсом SQL: SQLInterface 
- Для систем с интерфейсом OPC: OPCInterface 
- Для систем с интерфейсом STP: STPInterface 

� Если какие-либо из вышеперечисленных задач активны, их нужно закрыть. 
� Запустите систему MultiTrend из меню Пуск, либо пользуясь иконкой на Рабочем столе 
� Убедитесь, что MultiTrend находится в онлайновом режиме 
� Убедитесь, что запущены какие-либо интерфейсные модули 

5.8.3.5 Сообщения об ошибках и устранение проблем 

Ниже перечислены некоторые из наиболее общих проблем, могущих возникнуть в системах 
MultiTrend / Modbus, а также пути их разрешения: 

� Не поступают новые данные в систему управления 
Убедитесь, что система MultiTrend запущена и данные поступают. Если нет, проверьте 
наличие сообщений об ошибках и см. ниже. 

� В систему MultiTrend не поступают новые данные 
Проверьте, что она находится в онлайновом режиме. Проверьте, работают ли 
программы Modbus (RegSigMap и CorrMod) 
. Проверьте наличие сообщений об ошибках и см. ниже. 

� Различные ошибки связи, истечения временных интервалов ожидания, ответов 
системы 
Это означает, что на команды, посылаемые системой MultiTrend к подводным датчикам, 
не поступает ответных сигналов. Проверьте, получает ли сообщения модуль CorrMod. 
Для этого нужно включить режим журналирования и просмотреть журнал. Если 
сообщения не проходят, необходимо проверить кабели Modbus, а также 
функционирование управляющего блока Modbus 
. Если проблема не в этом, или если сообщения все же проходят, попробуйте 
перезапустить систему MultiTrend. Если это не помогает, свяжитесь со службой 
поддержки CorrOcean. 
support@corrocean.no 

� Различные сообщения об ошибках 
Проверьте значения показателей для датчиков потока и размера частиц для одной 
зоны. Для правильности вычислений по грунту, эти показатели должны быть 
корректными. 

5.9 Использование ПО MultiTrend для испытания подводных датчиков 
CorrOcean 

Зачастую бывает удобно использовать ПО MultiTrend для испытания подводных датчиков 
CorrOcean, а также имитаторов датчиков. Это позволяет легко осуществлять управление и 
документирование данных испытаний. В нижеследующих разделах подробно объясняется, как 
сконфигурировать систему MultiTrend для проведения таких испытаний. Предполагается, что 
система MultiTrend уже установлена на ПК. 

5.9.1 Создание конфигурационного файла MultiTrend 

Для создания чистого конфигурационного файла, выберите пункт меню File->New. Укажите 
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подходящее имя файла, например "SubseaSensorTest", так, чтобы его потом легко можно было 
найти. 

Подключение датчика к ПК 5.9.2 

Данный этап зависит от типа интерфейса датчика. Перед продолжением, обратитесь к 
документации датчика. 
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� Если датчик снабжен оригинальным интерфейсом CorrOcean RS485, он 
подсоединяется к последовательному порту RS232 на ПК при помощи переходника 
RS232-RS485. Достаточно надежным переходником, рекомендуемым компанией 
CorrOcean является переходник Westermo MD44. 

� Если датчик снабжен интерфейсом Modbus, то его также можно подсоединить к 
последовательному порту ПК при помощи переходника  
RS232-RS485. 

� Если используется какой-либо иной интерфейс, может понадобиться специальное 
оборудование и программное обеспечение для подключения датчика. В этом случае 
руководствоваться настоящей инструкцией не следует. 

5.9.2.1  Добавление интерфейса последовательного соединения Интерфейс 
Если датчик снабжен оригинальным интерфейсом CorrOcean RS485, то ПО MultiTrend должно 
быть настроено 
на работу с последовательным интерфейсом. Выберите пункт меню Edit->New->Interface, как 
показано на рисунке 6767 (либо 
выберите 
пункт контекстного меню New->Interface). Если датчик снабжен интерфейсом Modbus, 
обратитесь к разделу 
5.9.2.2. 
 

Рисунок 6767 Создание интерфейса 

Открывается окно выбора интерфейса, показанное на Рисунке 6868. Выберите Serial 
(Последовательный), и нажмите кнопку Next> . 
 

Рисунок 6868 Окно выбора интерфейса 
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Рисунок 6969 Окно конфигурации  порта 

Теперь в окне Instrument View содержится значок, соответствующий новому 
последовательному интерфейсу (См. Рисунок 7070) Выберите значок и выберите вкладку 
Настройка (Setup) в окне информации. Выберите скорость передачи данных, руководствуясь 
документацией датчика. В большинстве случаев, для остальных параметров можно оставить 
значения по умолчанию. 

 

Рисунок 7070 Установка свойств последовательного порта 

5.9.2.2 Добавление интерфейса Modbus в конфигурацию MultiTrend 
Если датчик снабжен интерфейсом Modbus, система MultiTrend должна быть сконфигурирована 
для работы с ним. Подробное описание по такой настройке см. в Руководстве Пользователя 
MultiTrend Modbus. Пропустите этот шаг, если датчик снабжен оригинальным интерфейсом 
CorrOcean RS485. 

5.9.2.3 Добавление подводного датчика 

Для того, чтобы добавить подводный датчик, выберите пункт меню Edit->New->Instrument, либо 
нажмите соответствующую кнопку на панели инструментов, либо выберите пункт New-
>Instrument в контекстном меню. Появится окно 
создания нового измерительного прибора (как показано на рис.7171). Введите идентификатор 
(ID) для датчика. Если датчику был присвоен корректный идентификатор в комплексной 
системе, мы рекомендуем использовать именно его. Выберите тип прибора SubSea 
(Подводный). Остальные поля заполняются по желанию. Нажмите кнопку OK. В окне Instrument 
View должен появиться небольшой значок синего цвета. Если он не соединен с 
последовательным интерфейсом, как показано на Рисунке 7272, то нужно мышкой перетащить 
его на значок COM1. 

 

Нажмите кнопку 
Finish для 
завершения 
создания 
интерфейса 

Если 
используемый 

вами 
последовательны

 

Выберите вкладку 
настроек (setup), 
чтобы открыть 
настройки 

Выберите новый 
интерфейс 

чтобы открыть 
окно с подробной 

Руководствуясь 
документацией 
датчика, выберите 
скорость 



CorrOcean ASA РЕД: 04 
РУКОВОДСТВО ПОЛЬЗОВАТЕЛЯ СИСТЕМЫ MULTITREND Страница:

 57 из125 
Документ №:    4174-16959-I-MU-0003 Дата: 03.10.04 
 
 

Рисунок 7171 Окно выбора измерительного прибора 

5.9.2.4  Проверка встроенного идентификатора (ID) датчика и связи с датчиком. 
 

Рисунок 7272 Вызов окна расширенной настройки Подводного измерительного прибора 

Откройте окно Расширенной настройки Измерительного прибора, Рис. 7272., нажав на кнопку 
Advanced Instrument Setup>> . Теперь можно посылать датчику команды и получать на них 
ответ. 
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Рисунок 7373  Выбор формата данных 

Выбранный формат данных должен соответствовать настройке датчика. Эту информацию 
можно взять в документации по датчику. 

Примечание 
Если вы работаете с датчиком, настроенным на автоматическую отсылку результатов замеров 
через определенные временные интервалы, то отправлять ему команды не следует. Более 
подробную информацию можно получить в документации по датчику. Если используется 
именно такой датчик, то в окне "ответных сигналов" будут отображаться данные с датчика, 
получаемые через определенные временные интервалы. 

ПРЕДУПРЕЖДЕНИЕ 
Не следует посылать датчику случайные, произвольные команды. Это может сбить его 
настройку. 
Вообще, датчикам, расположенным под водой, не следует посылать команд, изменяющих их 
конфигурацию 
. 

Выберите опцию "hex" (показано на  Рисунке 7474), и отправьте датчику следующую 
трехсимвольную команду: 
#01 
Ответ на команду представляет собой копию команды, но второй байт заменен на 
идентификатор датчика. 
Для определения идентификатора необходимо вычесть  30 (в шестнадцатеричном формате) из 
значения байта. Этот идентификатор приводится также в документации 
датчика. Он не обязательно соответствует серийному номеру. 

 

Рисунок 7474 Посыл команды датчику для определения его оригинального 
идентификатора (ID) 
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5.9.3 Устранение неполадок в соединении с подводным датчиком  

Если действия, описанные в разделе 5.9.2.3 не приводят к появлению ответного сигнала в окне 
"Response", то наиболее вероятные причины этого: 

� В настройке последовательного интерфейса MultiTrend неверно указана скорость 
передачи. 
� При настройке переходника RS232-RS485 была неверно указана скорость передачи 
� Не удается подключение переходника RS232-RS485 к ПК. Проверьте правильность 

подключения каналов  TX и RX. 
� Для корректной работы некоторых переходников RS232-RS485 требуются специальные 

каналы управления потоком, такие как например RTS и 
CTS. Сверьтесь с документацией переходника для решения данного вопроса. В данном 
случае, система MultiTrend должна быть сконфигурирована соответствующим образом. 
Кабель между переходником и ПК также должен быть оснащен подходящими 
разъемами. Переходник Westermo MD22 не требует аппаратного управления потоком. 

� Нет питания на датчике. Для проверки питания датчика используйте вольтметр. В 
случае если речь идет о виртуальном датчике, проверьте соответствующий индикатор 
питания. 

� Некоторые из соединений датчиков перепутаны. Проверьте все четыре соединения 
еще раз. 

� Если все подводные кабели/перемычки подключены, возможно, что какие-то из них 
неисправны. Попробуйте осуществить подключение без подводных кабелей/перемычек. 

� Выходы переходника перепутаны. На некоторых переходниках Westermo перепутаны 
обозначения на выходах. Попробуйте поменять порядок проводов. 

� Переходник имеет неподходящее для кабелей RS485 контактное сопротивление . 
� Сбилась настройка скорости переданных у датчика.Попробуйте установить это 

значение в 1200, 
9600 и19200 бод - в системе MultiTrend и на переходнике.Если проблема не исчезает, 
свяжитесь с представителями компании 
CorrOcean для получения технической поддержки. 

ПРЕДУПРЕЖДЕНИЕ 
При любых обстоятельствах, не пытайтесь менять значение скорости передачи данных 
на подводных датчиках, даже если вы знаете как! 

Если проверка вышеперечисленных причин не помогла , то, возможно, датчик неисправен. 
Свяжитесь с представителем CorrOcean для получения технической поддержки. 

5.9.4 Установка корректного идентификатора (ID) датчика в конфигурации MultiTrend 

Введите идентификатор, указанный в документации, или в разделе 5.9.2.4, см. ниже. 
 

Рисунок 7575 Смена идентификатора датчика ( ID) 
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5.9.5   Сбор данных измерений от подводных датчиков 

Данный шаг подразумевает, что подводный датчик и интерфейс уже добавлены в 
конфигурацию MultiTrend. 

Все результаты замеров, сохраняемые в системе MultiTrend, связываются с конкретными 
датчиками. Перед тем, как сохранять данные подводного датчика, необходимо добавить 
соответствующие датчики в конфигурацию. Подводные сенсоры могут иметь несколько типов 
датчиков: 

� Датчик грунта 
� Датчик ER-типа 
� Комбинированный датчик грунта/типа-ER 
� Датчик Давления/Температуры 
� Комбинированный датчик Грунта/Давления/Температуры 

5.9.5.1  Добавление датчика в конфигурацию MultiTrend 
Для того, чтобы добавить датчик, выберите пункт меню 
Edit->New->Probe,  выберите New->Probe из 

контекстного меню, либо выберите значок на панели инструментов ). 

 
Рисунок 7777 Окно выбора датчика 

Введите подходящий идентификатор. Так как сенсорный элемент вместе с входящими в него 
датчиками, является единым блоком, (называемым Подводным Датчиком в сборе или 
ПДС(SPA)), ему присваивается и единый идентификатор. Данный идентификатор уже 
использован, поэтому необходимо создать новый, например путем прибавления типа датчика к 
идентификатору сенсорного элемента.Так, если подводный сенсорный элемент имеет 
идентификатор XYZ, то идентификатор датчика типа ER, будет таким: XYZ-ER. Укажите тип 
используемого вами датчика (при необходимости, воспользуйтесь документацией по датчику). 

 
Рисунок 7676 Открытие окна выбора датчика 

Откроется окно выбора датчика, как показано на Рисунке 7777. 
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Если вы используете комбинированный датчик, то выберите один из входящих в набор, затем 
повторяйте этот шаг для каждого из датчиков в наборе.Остальные поля заполняются по 
желанию. По завершению нажмите кнопку Next>. 



CorrOcean ASA РЕД: 04 
РУКОВОДСТВО ПОЛЬЗОВАТЕЛЯ СИСТЕМЫ MULTITREND Страница:

 62 из125 
Документ №:    4174-16959-I-MU-0003 Дата: 03.10.04 
 
Выполнение следующего раздела зависит от типа используемого вами датчика: 

5.9.5.2  Настройка параметров датчика грунта 
Для определения количества элементов и контрольной толщины вашего датчика грунта, 
обратитесь к документации по датчику. Введите эту информацию в окне, как показано на 
Рисунке 7878, и далее нажмите кнопку Next. В следующем окне вам предлагается ввести 
дополнительную информацию о датчике. Эти параметры указываются по желанию. 

 
Рисунок 7878 Параметры датчика грунта 

5.9.5.3  Установка параметров датчика типа ER 
Для определения типа используемого вами ER-датчика, воспользуйтесь документацией. 
Введите необходимую информацию в окне параметров датчика типа ER. Если используемый 
вами тип датчика отсутствует, укажите Общий тип датчика. Затем нажмите кнопку Next>. В 
следующем окне вам предлагается ввести дополнительную информацию о датчике. Эти 
параметры указываются по желанию. 

 
Рисунок 7979 Параметры датчика типа ER 

5.9.5.4  Установка параметров датчика "давление/температура" 
В новых системах SenCorr вычисления производятся самим измерительным прибором, для 
этого выберите опцию SenCorr PT. Опция калибровки MultiTrend сохранена для совместимости 
с предыдущими версиями, а также для испытательных целей. 
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Рисунок 8080 Параметры датчика типа pT 

При использовании калибровки MultiTrend, отметьте галочкой пункт PreSens и нажмите кнопку 
PreSens Parameters - откроется окно настройки параметров, как показано на Рисунке 8181. 
Технический паспорт PreSens, входящий в комплект поставки этого датчика, содержит все 
необходимые параметры, которые необходимо ввести. Введите значения параметров, 
содержащиеся в техпаспорте Если у вас есть данный техпаспорт в электронном виде, можно 
воспользоваться функцией "вырезать и вставить" в программе MS Excel, для того, чтобы 
ввести эти параметры в систему MultiTrend напрямую. Нажмите кнопку OK, а затем кнопку 
Next>. В следующем окне вам предлагается ввести дополнительную информацию о датчике. 
Эти параметры указываются по желанию. Количество наборов параметров должно 
соответствовать техпаспорту. 
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Рисунок 8181 Параметры PreSens 

 

Параметр Приблизительно Точно Примечание 
a03-b092 T=от -20C до 20C T=от 20C до 80C  
A1 -6.80201703E-09 -2.06480369E-10 бар / °C / (мВ/В)^3 
A0 1.07458786E-05 1.05714147E-05 бар / (мВ/В)^3 
b1 -1.07753160E-05 -1.09558580E-05 бар / °C / (мВ/В)^2 
b0 1.62317966E-03 1.62873486E-03 бар / (мВ/В)^2 
C2 4.13213980E-06 5.31161729E-06 бар / °C^2 / (мВ/В) 
C1 1.30981651E-02 1.29908554E-02 бар / °C / (мВ/В) 
C0 6.38736090E+00 6.38884336E+00 бар / (мВ/В) 
D2 -1.49870908E-04 -6.13432244E-05 бар / °C^2 
D1 -5.07551509E-02 -5.70326539E-02 бар / °C 
D0 1.05175701E+01 1.06077120E+01 Бар 
E1 -4.34105105E-07 -3.04387268E-07 Ω/ °C / бар^2 
E0 1.17830547E-04 1.14379179E-04 Ω / бар^2 
F1 5.95773693E-05 -3.25263777E-07 Ω / °C / бар 
f0 -1.28554375E-01 -1.26937394E-01 Ω / бар 
G3 1.85204908E-07 1.29150363E-08 °C / Ω ^3 
G2 -3.49251223E-03 -2.74250587E-04 °C / Ω ^2 
G1 2.20415703E+01 2.00501439E+00 °C / Ω 
g0 -4.65255422E+04 -4.94734669E+03 °C 

Рисунок 8282 Копия фрагмента техпаспорта PreSens 

5.9.5.5  Проверка настроек датчика 
После добавления всех датчиков, которые необходимо проверить, окно Instrument View должно 
выглядеть как показано на Рисунке 8383. 
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Для всех 
испытываемых 

сенсорных 
элементов указаны 

корректные 

В комбинированных датчиках 
грунта/ER, датчик грунта обозначается 
Probe 1. Это можно поменять, 
временно перетащив один из 
датчиков на значок "неподсоединен", а 
затем указав здесь необходимый 
номер датчика. 

Убедитесь, что 
сенсорные элементы 

подсоединены 
к значку 

интерфейса 

Убедитесь, что 
датчики 

подсоединены к 
к значку 

сенсорного 
элемента 

Значки можно 
перемещать 
методом drag&drop 
для того, чтобы 
варьировать 
подключения 

Рисунок 8383 Окно Instrument View после добавления сенсорного элемента и датчиков 

5.9.5.6  Осуществление единичных замеров 
Выберите сенсорный элемент, который вы тестируете, выберите вкладку Commands и нажмите 
кнопку Retrieve Now! , как показано на Рисунке 8484. Появиться окно, в котором отображается 
прогресс выполнения команды. Сообщения о ходе выполнения операции отображаются в 
журнале сообщений. 

Примечание 
Если сенсорный элемент настроен на автоматическую передачу результатов замеров через 
определенные промежутки времени, 
необходимо соблюдать осторожность при посыле запроса. 
Воспользуйтесь документацией сенсорного элемента. 

 
Рисунок 8484 Снятие единичного замера с подводного сенсорного элемента 
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5.9.5.7  Снятие множественных замеров. 

Существует два разных способа получения данных по множественным замерам: 

(1) Замер, инициированный измерительным прибором 
(2) Замер, инициированный системой MultiTrend 

При использовании первого способа, интервал между замерами устанавливается как показано 
на  Рисунке 8585. 

 
Рисунок 8585 Замер, инициированный измерительным прибором 

После того, как вы укажите требуемый интервал, нажмите кнопку Send Setup to Instrument. 
Теперь управление замерами осуществляется подводным сенсорным элементом, а система 
MultiTrend получает от него информацию 
в онлайновом режиме. 

При использовании второго способа, интервал между замерами, а также время начального 
замера устанавливается пользователем и управляется  
системой MultiTrend. 
 
Задержка между командами "замер" и "передача" в  x секунд - соответствует задержке 
между посылами команд на осуществление замера и на передачу данных сенсорному 
элементу  
. 
Смотрите Рисунок 8686. 

 
Рисунок 8686 Замер, инициированный измерительным прибором 

Примечание 
В одно и то же время может использоваться только один из способов. 

 5.9.6 Интерактивный экспорт данных в Управляющие системы 

В случаях, когда обработанные данные необходимо представить в Управляющих системах 
более высокого уровня, их можно направить из системы MultiTrend при помощи одного из 
доступных интерфейсов, например, модуля CorrOcean Modbus. В данном модуле имеется 
программа перенаправления сигналов,  RegSigMap, которая позволяет посредством 
интерфейса Modbus представлять данные  (называемые в данном случае сигналами) вне 
системы MultiTrend. 

В качестве примера, мы рассмотрим конфигурацию MultiTrend с датчиком ER-типа, 
присоединенным к ПК с системой MultiTrend через подводный измерительный прибор и канал 
Modbus (показан как RegSigMap на Рисунке 8787). 
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Рисунок 8787 Датчик ER-типа в подводной системе (Modbus) 

Обработанные данные с датчика ER-типа могут быть перенаправлены через интерфейс 
Modbus, как показано на Рисунке 8888. 
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Рисунок 8888 Типовая схема перенаправления выходного сигнала 

При каждом обновлении значений данных в MultiTrend, выбранные сигналы будут направляться 
в Систему Управления (либо другую систему, подсоединенную через канал Modbus). 

См. также пункт 5.11.6 - Экспорт и Импорт данных. 

 5.9.7 Интерактивный импорт данных из Управляющих систем  

В ряде случаев, Управляющая система может ретранслировать параметры процесса, такие как 
информация об интенсивности потока, давлении и температуре, при помощи доступных 
интерфейсов, например модуля CorrOcean Modbus.   В данном модуле имеется программа 
перенаправления сигналов,  RegSigMap, которая позволяет посредством интерфейса Modbus 
представлять данные  (называемые в данном случае сигналами) вне системы MultiTrend. Этот 
метод является альтернативой ручному вводу этих параметров в систему MultiTrend. 

В качестве примера, мы рассмотрим конфигурацию MultiTrend с датчиком грунта, 
присоединенным к ПК с системой MultiTrend через подводный измерительный прибор и канал 
Modbus (показан как RegSigMap на Рисунке 8989). 

 
Рисунок 8989 Датчик грунта в подводной системе (Modbus) 

В расчетах по грунту, информация с датчиков об интенсивности потока, размере частиц 
используется в качестве входных данных. 
Когда, например, из Управляющей системы ретранслируется информация по интенсивности 
потока, она попадает в систему MultiTrend посредством канала  
Modbus и системы RegSigMap. 
На Рисунке 9090 приведен пример перенаправления сигнала для импорта данных в систему 
MultiTrend. 
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Наименование датчика Единицы измерения Размер регистра Отображение данных 
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Рисунок 9090 Перенаправление импортируемых данных 

 5.9.8 Выбор байтовых последовательностей  

В различных Управляющих системах используются различные байтовые последовательности 
для передачи пакетов данных через Modbus. 
В колонке Register Format системы RegSigMap, можно выбирать формат регистров для 
установления соответствия 
с байтовой последовательностью Управляющей Системы, как показано на Рисунке 9191. 

 
Рисунок 9191 Выбор байтовой последовательности 

На рисунке 9292 показаны различные модели перестановки байтов и слов. 
 

 

 

Стандарт
ные 

A B C D E F G Н 

         
Перестановл. 
байт 

G Н E F C D A B 

         
Перестановл. 
слово 

E F G Н A B C D 

         
Перестановл. 
Байт/Слово 

C D A B G Н E F 

Рисунок 9292 Перестановка байтов и слов 
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5.10 Использование ПО MultiTrend с контрольными пластинами потери 
массы 

5.10.1 Общие положения 

Контрольная пластина потери массы представляет собой датчик, который анализируется 
вручную для определения коррозии/эрозии в системе.Теперь стало возможно сохранять данные 
для этого датчика в системе MultiTrend. 

 5.10.2 Установка  

Так как данные по контрольной пластине потери массы вводятся вручную, то добавлять их и 
работать с ними нужно через окно General View. Увидеть их можно рядом со значком 
"неподсоединен" в окне Instrument view. 

5.10.2.1    Создание конфигурации MultiTrend 
Для создания чистого конфигурационного файла, выберите пункт меню File->New. Укажите 
подходящее имя файла, например "Weight Loss Coupon", так, чтобы его потом легко можно 
было найти. 

5.10.2.2 Создание "древовидной" структуры системы 
Для удобной визуальной организации датчиков, используются элементы "system" и "pipe". 
Для добавления элемента "система", щелкните правой кнопкой по корневому элементу 
структуры в окне General View, и выберите пункт "system" в контекстном меню, Рисунок 9393. В 
диалоговом окне "Create new system", введите подходящее название системы. Добавьте в 
систему элемент "pipe" (труба), а также элемент  "Weigth loss coupon" (контрольная пластина 
потери массы) - тем же способом, как вы добавляли  элемент "system"  в корневой раздел. Для 
добавления элемента "Weigth Loss Coupon" к трубе, необходимо выбрать пункт “probe” из 
контекстного меню; после этого появится диалоговое окно, как показано на Рисунке 9494. 
Введите идентификатор датчика и выберите тип "Weight Loss Coupon" из выпадающего списка. 

 

Рисунок 9393 Добавление элемента 
"System" 

Рисунок 9494 Добавление датчика 

�: 0 завершения установки датчика, заполните дополнительно предлагаемые в нижеследующих 
диалоговых окнах, поля параметров (опционально) Окончательная конфигурация должна 
выглядеть следующим образом, см. Рисунок 9595. 
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Рисунок 9595 Конфигурация контрольной пластины потери массы 
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5.10.2.3  Регистрация замера датчика 
Выберите датчик потери массы; подробная информация по датчику появится в правой части 
экрана, как показано на Рисунке 9696.Выберите вкладку “Commands”. Нажмите кнопку “Initial 
Coupon Data >>”. 

 
Рисунок 9696 Окно подробной информации 

В окне Начальные данные контрольной пластины потери массы (Weight Loss Coupon Initial 
Data), показанном на Рисунке 9797 ( часть окна по снятию контрольной пластины не показана) 
указываются данные при установке контрольной пластины; по завершению ввода нажмите OK. 
Для внесения данных после снятия контрольной пластины, нажмите кнопку “Removed Coupon 
Data >>” . Откроется диалоговое окно, в котором есть дополнительный раздел - для ввода 

 
Рисунок 9797 Данные по снятой контрольной пластине 
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данных по снятию пластины (removal of coupon). Введите необходимые данные для снятой 
пластины. Нажмите OK по завершению. 
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5.10.2.4  Диаграмма на основе данных 
Для построения диаграммы на основе данных, выберите вкладку “Calculations”. Для вывода 

диаграммы нажмите  кнопку Для просмотра данных в табличном формате, 

 нажмите кнопку . См. раздел  5.12.1.1 для получения более подробной информации о 
построении диаграмм. 

Рисунок 9898 Вывод диаграммы по 

показателям контрольной пластины 

потери массы 5.11   Управление 

обработкой данных 

 5.11.1 Удаление датчиков 

В окне General View или Instrument View, выберите датчик, который хотите 

удалить. 

Датчики можно удалять двумя способами: 

1. Выберите пункт меню Edit ->Remove Probe 

2. Выберите пункт Remove Probe из контекстного меню датчика 

 
Рисунок 9999 Удаление датчика 

Любое из этих действий вызовет появление предупреждающего сообщения о том, что все 
данные замеров по датчику также будут удалены.Если вы все же хотите удалить датчик, 
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нажмите кнопку OK, если нет - кнопку Cancel 

ПРЕДУПРЕЖДЕНИЕ 
При удалении датчика будут также удалены все его параметры и результаты замеров! 

 5.11.2 Удаление конфигураций  

Для удаления конфигурации, нужно удалить содержащие ее файлы при помощи файлового 
менеджера. 

ПРЕДУПРЕЖДЕНИЕ 
При удалении конфигурации, информация по всем приборам и  датчикам в данной 
конфигурации, будет удалена. 
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5.11.2.1  Удаление измерительных приборов 

В окне Instrument View, выберите прибор, который хотите удалить. 

Приборы можно удалять двумя способами: 

1. Выберите пункт меню Edit ->Remove Item 

2. Выберите пункт  Remove Item из контекстного меню прибора 

 
Рисунок 100100 Удаление прибора 

Нажмите OK, если вы все еще хотите удалить датчик. 

Датчики, которые были присоединены к прибору, переместятся в группу "Неподключенные 
датчики" (Unconnected probes) в окне Instrument View. 

 5.11.3 Резервное копирование конфигураций 

Все данные датчиков в системе MultiTrend сохраняются в единой базе данных, где для каждого 
датчика предусмотрена отдельная таблица. При помощи команды меню File->Backup можно 
произвести резервное копирование базы данных и файла конфигурации (файлы с 
расширением .mdb и .mcf, соответственно). 

 
Рисунок 101101 Резервное копирование конфигурационного файла и базы данных 

Эта команда создает копию активной конфигурации а также соответствующей ей 
базы данных. Исходные файлы остаются без изменений. 

 5.11.4 Сжатие базы данных 

Если база данных слишком разрастается, для уменьшения ее размеров и освобождения 
дополнительного дискового пространства можно применить сжатие данных. Это можно сделать 
двумя способами. 

5.11.4.1  Замена базы данных Это 
наипростейший способ: �     
Остановите систему MultiTrend 
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� Переименуйте файл базы данных, например, добавив к нему какое-либо число (так 
можно сохранять множество нумерованных баз данных) 
. Например, Файл ExampleConfig.mdb можно переименовать в ExampleConfig 001.mdb, 
ExampleConfig 002.mdb и т.д. 

� Скопируйте файл конфигурации, и назовите его тем же именем. Например,Скопируйте 
файл ExampleConfig.mcf в файл 
ExampleConfig 001.mcf 

� Запустите систему MultiTrend. MultiTrend загрузится с пустым файлом базы данных 
(Автоматически создается новый файл). Старый файл следует заархивировать для 
дальнейшего использования. 

Недостатком данного метода является то, что нельзя сопоставить диаграммы по старым и по 
новым данным. 

5.11.4.2  Сжатие данных 
Для сжатия базы данных, проделайте следующее: 

� Сделайте резервную копию базы данных (как описано в разделе  5.11.5). Используйте 
существующее имя файла - просто добавьте номер. Например: ExampleConfig002 

� Осуществите сжатие базы данных, как описано на Рисунке 102102 и  103103. Повторите 
операцию для всех типов датчиков. 

Процедура сжатия основана на принципе удаления результатов замеров, находящихся в 
границах предельных показателей  
предыдущего и последующего замера. Таким образом, величина предельных показателей 
определяет, насколько приближенными будут ретроспективные 
данные. Чем выше предельный показатель, тем больше результатов замеров будет удалено и, 
соответственно 
ретроспективный обзор становится менее детальным. 
Сжатие данных можно выполнять как для конкретных датчиков, так и для всех датчиков в 

конфигурации. 
Рисунок 102102 
Сжатие базы 
данных (1) 

 

Выберите один 
датч
ик 
грунт
а 

Выберите 
вкладку 
Commands 

Нажмите 
кнопку 
Database  
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Рисунок 103103 Сжатие базы данных (2) 

Примечание 
Сжатие данных нельзя отменить. 
Данные, удаленные во время сжатия, не подлежат восстановлению. 

При активации режима "Автосжатие в полночь" (Automatic compression at midnight), сжатие 

будет производится на основе указанных параметров. 

Примечание 
Во время процедуры сжатия приостанавливается любой прием данных. 
В случае большого размера базы данных, процесс сжатия может занять некоторое время - 
поэтому применять автоматическое сжатие не рекомендуется, если  первостепенное значение 
играет прием данных. 
 

 5.11.5 Резервное копирование файлов 

� Войдите в сервисный режим 
� Выберите пункт меню File->Backup 
� Введите подходящее имя и место расположения резервируемых файлов. 

 5.11.6 Экспорт и импорт данных 

В системе MultiTrend версии 2.29 и более старших, содержится функция экспорта данных в 
файлы с кодировкой ASCII, - через определенные интервалы времени или по мере 
поступления новых данных.Например, все данные, накопленные с момента предыдущего 
экспорта, можно сохранить в такой файл, находясь в море, затем переслать по электронной 
почте на компьютер с системой MultiTrend, расположенный на берегу.Здесь данные можно 
добавить в имеющуюся базу данных. Как вариант, данные из системы MultiTrend можно 
экспортировать на конкретную машину в локальной сети, так, что пользователи сети смогут 
импортировать его на своих  рабочих станциях.  

Пользователь может выбрать, какие данные экспортировать, а также настроить MultiTrend на 
автоматический импорт данных во время запуска. 

5.11.6.1  Экспорт данных 
Для экспорта данных по датчику, выберите пункт меню File->Export Data. 
Экспорт данных может выполняться вручную, либо автоматически в онлайновом режиме. 
Ручной экспорт возможен в двух вариантах - экспорт данных, накопленных с момента 
последнего экспорта, либо экспорт данных за определенный 
 период.При автоматическом экспорте в онлайновом режиме, вывод данных производится 
каждый раз при поступлении новых данных в систему  
MultiTrend. 

 

Рекомендуется 
сохранить недавние 

показатели, чтобы 
можно было 

Не рекомендуется 
Применять 
аналогичное 
сжатие ко всем 
датчикам этого 
типа 

После установки 
параметров, 
производить 
сжатие для всех 
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Пользователь может выбрать, данные по каким датчикам экспортировать, а также какие 
единицы измерения необходимо использовать. 
Сигналы для каждого из типов датчиков предопределены заранее. 
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При нажатии кнопки Save and export либо Save and close, настройки диалогового окна Экспорт 
сохраняются. При экспорте вручную, пользователю задается вопрос - произвести дописывание 
либо замену, в случае если указанный файл экспорта уже существует. 

На рисунке 104104 показано окно Экспорт. 
 

Рисунок 104104 Окно Экспорта 

Экспортируемый ASCII-файл содержит как стандартный заголовок, так и сами данные. 

5.11.6.2  Импорт данных 

Для осуществления импорта данных вручную, выберите пункт меню File->Import Data.  В 
открывшемся диалоговом окне предложено пять доступных типов импортируемых файлов: 

 

1. MultiTrend Export Files (*.txt) – ASCII-файл, экспортированный при помощи функции 
экспорта системы MultiTrend. 
2. SandRater Temporary File (*.tmp) – ASCII-файл, содержащий временные данные 
SandRater. 
3. SandRater/CorrList Files (*.dat) – Файлы данных, используемые в программах 
Sandrater/Corrlist 
4. MultiCom Files (*.txt) – Файлы данных, используемые в программе Multicom 

Если, например, для импортирования выбран файл, ранее экспортированный из MultiTrend, 
откроется диалоговое окно, показанное на Рисунке 105105. Выберите сигнал(ы), которые нужно 
импортировать и нажмите Import. 

 

Просмотр через 
окно General View 
либо Instrument 

Укажите файл для сохранения данных 

Укажите время 
старта - для 
экспорта в 

Укажите 
интервал для 
экспортирования 

Выберите сигналы для экспорта 

Укажите единицы 
измерения для 
выбранных сигналов 

Для автоматического 
экспорта в 
онлайновом режиме, 

Сохранить настройки и экспортировать Сохранить настройки Отмена, без сохранения 



CorrOcean ASA РЕД: 04 
РУКОВОДСТВО ПОЛЬЗОВАТЕЛЯ СИСТЕМЫ MULTITREND Страница:

 81 из125 
Документ №:    4174-16959-I-MU-0003 Дата: 03.10.04 
 

 
Рисунок 105105 Выбор сигналов для импорта 

Для включения функции автоматического импорта данных при запуске, выберите пункт меню 
Edit->Options, далее вкладку “Automatic File Import” , как 
показано на Рисунке 106106. 
Отметьте галочкой пункт "Import the following file after start-up" (При запуске импортировать 
следующий файл) и, по желанию, "Delete the file after import" (Удалять файл после 
импортирования), и укажите 
файл, который нужно импортировать.  Опция, включающая удаление не должна 
использоваться, если предполагается доступ более чем одного пользователя к 
экспортированному файлу. 
Нажмите ОК и сохраните конфигурацию MultiTrend. 
Если импортируемый файл содержит данные, которые уже содержатся в базе данных, то они 
игнорируются. 

 
Рисунок 106106 Настройка автоматического приема (импорта)  данных 

5.11.6.3  Импорт файлов SandRater 
Функция импорта файлов SandRater поддерживает прием ретроспективных данных из файлов 
SAnn.TMP и SAnn.DAT. 
Идентификационные номера и параметры датчика, содержащиеся в файлах PROBE.DBF или 
HIST.DBF не импортируются 
и должны вводиться вручную. 
Значения величин температурной компенсации также не импортируются и должны быть 
введены вручную, либо рассчитаны 
в системе MultiTrend. Значения температурной компенсации из SandRater (и технических 
паспортов датчиков) могут 
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быть использованы,  но с небольшими модификациями. 
Так, параметр A (коэффициент) системы SandRater нужно поделить на  1000000 (106) и ввести 
в систему MultiTrend  
 как параметр B . 
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5.12   АНАЛИЗ ДАННЫХ 

В данном разделе описываются различные способы анализа данных по различным 
датчикам в системе MultiTrend. Особый упор сделан на наиболее широко 
распространенных датчиках. 

5.12.1.1  Построение диаграмм на основе данных 
Система MultiTrend имеет мощный инструментарий для построения диаграмм/графиков. Для 
доступа к этой функции, выберите пункт "plot" из контекстного меню 
, либо щелкните соответствующую кнопку на панели инструментов, либо в окне Подробной 
информации ( Detail Window), чтобы открыть 
окно выбора данных для диаграммы, показанное на Рисунке 107107. После отбора 
информации, щелкните кнопку OK. Откроется окно построения диаграммы с установленным по-
умолчанию масштабом оси.Используя функции масштабирования, панорамирования и 
линейки, можно выбрать наилучший обзор. 
 

В этом окне 
выберите данные 
,на основе которых 
вы хотите 
построить 
диаграмму, и 
добавьте их в 
списки, 
соответствующие 
координатным осям 
при помощи кнопок 
Add 

Выберите 
единицы 
измерения для 
построения 
диаграммы 

Укажите 
название 
диаграммы 

Укажите диапазон 
данных, 
на основе которого 
будет строиться  
диаграмма 

Рисунок 107107 Окно выбора данных для построения диаграммы 

5.12.2 Анализ датчика грунта 

Варианты анализа датчика грунта можно увидеть, выбрав датчик в одном из трех окон 
(General, Instrument и Status). 

5.12.2.1  Анализ данных по грунту 
Наилучший способ проанализировать данные по грунту - это построить диаграмму потери 
металла.Плоская кривая - означает отсутствие эрозии, и , соответственно, отсутствие 
воздействия песчаной эрозии. Повышение на диаграмме означает появление эрозии, и 
соответственно вынос песка. Значительное снижение потери металла может происходить при 
больших изменениях температуры датчика, например при отключении. При стабилизации 
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температуры, нормализуется и показатель потери металла (до прежнего уровня). 
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Рисунок 108108 Варианты анализа датчика грунта 

Существуют следующие варианты: 

5.12.2.2  Потеря металла 
Рассчитывает потерю металла для каждого из элементов датчика на основе показателя 
сопротивления элемента. 
Нажмите кнопку , чтобы построить диаграмму потери металла датчика. 
Нажатие на кнопку F>> откроет доступ к параметрам анализа.    Здесь можно 
рассчитать отклонения в потере металла, а также использовать фильтры. 
На рисунке 109109 представлено диалоговое окно настройки параметров расчета потери 
металла. 

 
Рисунок 109109 Параметры расчета потери металла 

Различные параметры и настройки расчета описаны на следующей странице. 

5.12.2.3  Отклонения 
Есть два способа добавить смещение к сигналу. 

Выбор опции Initial Metalloss (начальная потеря металла) - позволяет добавить 
смещение к первому образцу из набора данных.Все остальные элементы данных будут 
смещаться относительно первого. Величина смещения вводится в окне "подробная 
информация -> параметры" (detail window -> parameters) для конкретного датчика, Рисунок 
110110. На рисунке 112112 показана начальная потеря металла в  2мм. Эта опция нужна для 
того, чтобы обеспечивалась непрерывность в собираемых данных после замены датчика. 
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Рисунок 110110 Окно подробной информации 

При нажатии на кнопку Calculate offset (Рассчитать смещение), ко всем элементам в 
последней текущей записи будет добавлено смещение.При этом, точка отсчета будет сдвинута 
к нулевой линии, либо к уровню начальной потери металла (если эта величина используется). 
Все остальные данные также сместятся относительно этой точки. При установке нового 
датчика, нужно обязательно использовать данную функцию. При этом, нужно сначала снять 

 

Рисунок 111111 Сигнал без смещения 
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первое показание с датчика, а затем уже рассчитывать смещение. 
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Рисунок 112112 Сигнал с начальным смещением  2µм 

 

Рисунок 113113 Сигнал с рассчитанным смещением -4мм 
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5.12.2.4  Температурная компенсация 

Функционирование датчиков грунта в некоторой степени может зависеть от окружающей 
температуры. Это может быть заметно при построении диаграмм во время значительных 
температурных перепадов - например во время запуска системы, или останова. Для того, 
чтобы скорректировать эти отклонения, может использоваться температурная компенсация. В 
техническом паспорте, входящем в комплект поставки датчика, указаны все необходимые 
значения по этой функции.Для ее активации необходимо ввести приведенные в техпаспорте 
данные, и затем отметить галочкой пункт "Do Temperature Correction" (Осуществлять 
температурную коррекцию) в окне Metal Loss Calculations (Расчеты по потере металла). Если 
в техпаспорте датчика приводится только одно “A” и одно “B” значение, используйте те же 
величины для всех элементов. 

 

Укажите необходимый 
интервал 

Использовать # 
параметров (см. 
техпаспорт датчика) 

Введите значения 
параметров из 
техпаспорта датчика 

Рисунок 114114 Параметры Температурной компенсации 

Как вариант, величины могут быть рассчитаны системой MultiTrend. Для того чтобы проделать 
это, введите подходящий временной диапазон, в течение которого имело место значительное 
изменение температуры  (запуск или останов) и нажмите кнопку Calculate Parameters 
(Рассчитать параметры). MultiTrend автоматически рассчитает оптимальные параметры. При 
этом можно сгенерировать от 2 до 4  параметров. Параметр A - это расчетная средняя 
контрольная величина в Омах. Параметры  B, C и D  - компенсационные. Коэффициент 
корреляции (Correlation Factor) показывает корреляцию между изменениями в  значениях 
элементов -  контрольных и полученных в результате замеров . Величина около 1.0 
означает очень хорошую корреляцию, и, соответственно хорошую температурную 
компенсацию. Величина менее 0.5 означает низкую корреляцию значений в двух наборах 
данных. 

При расчете параметров компенсации, всегда следует проверять полученные результаты 
путем построения диаграммы.Диаграмма, отражающая динамику, в двух вариантах - с 
температурной компенсацией и без нее - очень хорошо показывает эффект заданных 
параметров. 

ПРЕДУПРЕЖДЕНИЕ 
Данные действия должны производиться только опытным персоналом! 
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5.12.2.5  Параметры фильтра 
Установка фильтров осуществляется путем проставления галочек напротив соответствующих 
пунктов, показанных на Рисунке 115115. 

Рисунок 115115 Настройка фильтра 

Фильтр усреднения 
Настройка фильтра усреднения позволяет установить интервал, выше которого значения будут 
усредняться. 
 

Фильтр пиков 
Величина Delta limit (Предел приращения) устанавливается таким образом, чтобы любые 
показатели вне данного предела, не учитывались. 
Величина Spike width (Ширина пика) определяет, сколько значений величин должны 
превысить предел приращения, до того момента, как значения будут приняты. 
 
Величина Filter width (Ширина фильтра) определяет, сколько "предыдущих" значений будет 
учитываться системой MultiTrend при расчете среднего значения. 

Пики могут иметь как одну точку (Пик 1), так и несколько (Пики 2 и 3). Настройки фильтра пиков 
определяют, каким образом система MultiTrend будет их обрабатывать. Сдвиги амплитуды (по 
оси Y) могут также быть участками,  которые необходимо отобразить на конечной диаграмме. 

 

Отметьте 
гал
очк

Пик 1 Пик2 Пик3 
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Рисунок 116116 Неотфильтрованные пики 
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В данном примере, мы  полагаем, что Пики 1 и 2 - “подлинные” пики, Рисунок 116116.  Их нужно 
отфильтровать, 
при этом сохранив Пик 3. 
Для этого настройка фильтра должна быть следующей: 

 

Рисунок 117117 Настройка фильтра пиков 

Для предела приращения (Delta Limit) устанавливается значение 3 мм, т.к. нам нужно 
отследить все "всплески" амплитуды, превышающие  3 мм. 
Ширина пиков в значениях величин (Spike Widths in samples) равна 2, т.к. нужно удалить все 
"скачки" амплитуды  (свыше 3 мм), 
состоящие только лишь из 1-й точки (замера). 
Этому параметру нельзя присвоить значение менее 2. 
Установив значение поля Ширина фильтра в значениях величин (Filter Width in samples) 
равным 10, мы делаем так, чтобы удаляемые точки данных замещались средними значениями 
на основе 
8-ми предыдущих замеров. Значения величин, используемые для расчета средних значений, 
определяются на основе разности Ширины усреднения (Average Width) 
и Ширина Пика (Spike Width) (т.е . Average Width минус Spike Width). 
Окончательный вариант диаграммы должен выглядеть как показано на Рисунке 118118: 

 
Рисунок 118118 Отфильтровываются пики шириной менее 2-х точек 

Заметьте, что пики, состоящие из 2-х и 3-х точек данных также фильтруются, но у них 
вырезается только первая точка. 
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Рисунок 119119 Отфильтровываются пики шириной менее 3-х точек 

Для того, чтобы установить правильные настройки фильтра, сначала нужно просмотреть 
данные, на основе которых вы хотите построить диаграмму. Если в диаграмме имеются пики, 
для того, чтобы фильтрация давала хорошие результаты, нужно определить соответствующее 
значение пороговой амплитуды, устанавливаемой в качестве порогового значения (Delta Limit), 
а также максимальное количество точек данных, которые может содержать один пик (Ширина 
пика в значениях величин/Spike width in samples). На рисунке 120120 показана диаграмма 
набора данных с шириной пика равной  4. 

 
Рисунок 120120 Отфильтровываются пики шириной менее 4-х точек 

Параметры фильтра используются для задания параметров усреднения.Когда фильтр 

 

Если ширина пика возрастает до 3-х точек, то результат будет выглядеть следующим образом, 
см. Рисунок 119119 
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включен, значения, отображаемые в окнах Probe Status View (Состояние датчика), Calculations 
View (Расчеты), а также на динамических диаграммах , основаны на текущих настройках 
параметров. 
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Можно отображать динамические диаграммы с различными настройками фильтров, меняя эти 
настройки а затем строя новые кривые по новым параметрам, при помощи функции Add Curve 
(Добавить кривую) в окне  Graph Window. 

Примечание 
При изменении настроек фильтра в окне построения диаграммы, не происходит изменения 
настроек, произведенных в окне  
 
 Probe Calculations (Расчеты по датчику).  

5.12.2.6 Интенсивность эрозии 
Интенсивность эрозии рассчитывается на основе показателя потери металла. При этом, на 
расчет данного показателя не влияет использование каких-либо фильтров усреднения. 
Однако, любые настройки касательно пиков, влияют на эти расчеты.Доступ к диалоговому окну 
расчета интенсивности эрозии можно получить, нажав кнопку F>> напротив поля Erosion Rate в 

окне подробной информации (Рисунок 121121). 

 
Рисунок 122122 Расчет интенсивности 

Интенсивность эрозии рассчитывается на основе двух или более замеров величины потери 
металла, определяемых величиной "integration period" (интервал интеграции данных) в 
диалоговом окне Расчет Интенсивности(Rate Calculation). 

Обычно, достаточно интеграции 6-10 замеров. Это позволяет произвести расчет быстро и с 
минимальными погрешностями.Если процесс все же занимает слишком много времени, можно 
уменьшить интервал интеграции. Соответственно, при его уменьшении снижается время 
расчетов, но и возрастает погрешность (особенно, если при этом используются сигналы с 
высоким уровнем "шума"). 

Для датчика грунта, показатель интенсивности эрозии является одним из входных параметров 
расчетов по грунту. 

5.12.2.7  Интенсивность потока грунта 
Данная величина рассчитывается на основе характеристик выноса грунта (скорости потока и 
размера частиц). 
При этом, при настройке параметров можно выбрать, какие датчики потока и размера частиц 

 
Рисунок 121121 Варианты анализа датчика грунта 
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будут использоваться 
для расчетов по грунту. Датчики можно выбрать из меню. 
Здесь же можно указать положение датчика в группе (передний/задний), поставив галочки 
напротив соответствующих пунктов. Открыть диалоговое окно с настройками данных 
параметров можно, нажав кнопку F>> напротив пункта Sand Rate в окне подробной 
информации 
(рисунок 121121). 
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Рисунок 123123 Параметры расчета интенсивности потока грунта 

Изменение параметра "probe position" (положение датчика) влияет на константы показателя 
выноса грунта. Эти значения установлены в системе MultiTrend по-умолчанию. Для задания 
иных значений констант, нужно снять галочку с пункта ‘defaults’, а затем ввести новые значения 
в соответствующих полях. 

ПРЕДУПРЕЖДЕНИЕ 
Изменение вышеописанных значений констант допускается только опытным персоналом! 

5.12.2.8  Содержание грунта 
Примерное количество песка (отн. нефти, воды и/или газа), можно рассчитать, а затем вывести 
эти данные для изучения. Доступ к диалоговому окну расчета этого параметра можно получить, 
нажав кнопку F>> напротив поля Sand Content в окне подробной информации (Рисунок 121121). 
Выберите вещество, как показано на Рисунке 124124. 

 
Рисунок 124124 Параметры расчета содержания грунта 

5.12.3 Анализ по датчику ER-типа 

 Анализ по датчику ER-типа  включает в себя оценку характеристик Потери Металла, а также 
интенсивности коррозии. 
Настройки и общий функционал аналогичны описанным для Датчика грунта в разделах 5.12.2.2 
и 5.12.2.6. 

5.12.4 Аналоговый датчик 

Аналоговый датчик действует как вольтметр, и соответственно, используется для измерения 
напряжений. 
Данные можно представить в разрезе различных измерений, а затем обработать при помощи 
математических методов (при помощи Полиномиальных вычислений, как показано на рисунке 
125125). Открыть диалоговое окно для доступа к данным функциям можно, нажав кнопку F>> в 
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окне подробной информации. 
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Рисунок 125125 Полиномиальные вычисления 

Для обработки результатов замеров (x), используется формула  
В поля Constants (Константы) вводятся значения; и 

далее, производится математическое вычисление. 
Если никакого расчета осуществлять не требуется (например, нужно оставить исходные 
значения), значение константы C устанавливается равным 1, остальные константы - равны 
нулю. 
 
 
Помимо вышесказанного, к данным могут применяться фильтры. Настройки фильтров описаны 
в разделе 5.12.2.2. 

5.12.5 Датчика Температуры/Давления 

В датчике Температуры/Давления предусмотрена функция корректировки относительно 
температуры окружающей 
среды. 
Диалоговое окно, соответствующее данной функции показано на Рисунке 126126. Открыть это 
окно можно щелкнув кнопку 
F>> в окне подробной информации. 

 
Рисунок 126126 Калибровка расчетов по температуре 

ПРЕДУПРЕЖДЕНИЕ 
Данная функция должна использоваться только опытным персоналом. 

5.12.6 Прочие типы датчиков 
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Для прочих типов датчиков действуют все вышеописанные функции Температурной 
компенсации, а также применения фильтров. 
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6 ТЕХНОЛОГИЯ FSM В СИСТЕМЕ  MULTITREND 

В данной главе описывается, как можно использовать измерительные приборы, основанные на 
технологии FSM, в ПО MultiTrend. Поддержка этой технологии в MultiTrend начата с версии 
3.01. 

7 ЧТО ТАКОЕ FSM? 

 7.1 FSM - Метод оценки характеристик электрического поля 

Методика FSM основывается на отслеживании изменений в характеристиках электрического 
поля, создаваемого на исследуемом объекте. На основе интерпретации этих изменений 
(разностей электрических потенциалов), можно сделать определенные выводы - в частности, 
об  интенсивности процессов коррозии, или образовании трещин. 

7.2 Принципы проведения измерений 

Технология FSM является инструментом контроля коррозии/эрозии, предназначенным для 
обнаружения даже мелких изменений толщины стенок труб. Методика предполагает 
пропускание управляемого тока возбуждения через исследуемую структуру, для создания 
уникальной характеристики электрического поля. Любые последующие изменения в 
электрическом поле, вызванные процессами коррозии или эрозии, фиксируются как падение 
потенциала на присоединяемых с наружной стороны трубы контактах датчика. 

 
Рисунок 127127: Подача тока возбуждения на трубу. Распределение токов и 
потенциалы образуют стабильную структуру. 

 
Рисунок 128128: Труба с местным дефектом (с подачей возбуждающего тока). 
Распределение токов, а также электрические потенциалы будут меняться в области 
дефекта. 
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7.3 Типы коррозии 

7.3.1 Общая коррозия: 

Под общей коррозией понимается равномерная потеря металла внутри структуры, приводящая 
к повышенному суммарному сопротивлению. Распределение тока будет равномерным, а 
уменьшение толщины стенок будет линейно-пропорционально повышению сопротивления и 
напряжению на контактных парах. Повышение напряжения на контактных парах можно 
представить в качестве показателя общей потери металла. 

7.3.2 Коррозия вершины сварочного шва / коррозия в виде борозд: 

Коррозия вершины сварочного шва может возникать в сварных сегментах металлической 
конструкции.На трубах, коррозия такого типа принимает форму борозды вдоль  шва по 
окружности трубы.Ширина борозды часто сравнима с расстоянием между контактными парами. 
Учитывая то, что потеря металла обычно не равномерна, и затрагивает определенные участки 
металлической конструкции, замеры толщины стенок будут крайне недостоверным 
показателем.Измерения, получаемые по технологии FSM, необходимо дополнить 
эмпирической моделью коррозии вершины сварочного шва, где фактическая глубина борозд 
рассчитывалась бы при помощи специального алгоритма. 

7.3.3 Питинговая коррозия: 

Питинговая коррозия является гораздо более сложной, по сравнению с коррозией шва. На 
участках ее проявления, повышенное сопротивление будет приводить к тому, что эл.ток будет 
протекать "вокруг" этих участков. Комбинация данных в матрице FSM будет показывать самое 
большое значение на вершине коррозийной язвы, возрастающие значения на ее краях, и, 
соответственно, отрицательные значения перед ней и за ней (отн-но направления тока FSM). 
Коррозионная язва будет выглядеть шире, чем на самом деле; при этом ее глубина будет 
серьезно недооценена. 

Если анализ питинговой коррозии вообще не используется, то замеры толщины стенок будут 
давать заниженные значения.Осуществление этого вида анализа в системе MultiTrend 
невозможно до Мая 2003. ВНИМАНИЕ! В настоящее время, требуется проведение ручного 
анализа такого рода специалистами CorrOcean. 

7.3.4 Эрозия на изгибах 

При подмешивании грунта в поток жидкости, изгибы трубопровода будут подвергаться 
серьезному эрозийному воздействию его частиц. Геометрия эрозии может быть различной - в 
зависимости от характеристик процесса, а также от материала трубы. Кроме того, эрозийные 
повреждения распределяются неравномерно. Наибольшая потеря металла отмечается на 
внешней кривой изгиба трубы. 

В связи с таким неравномерным распределением эрозии, ее глубину также нельзя адекватно 
оценить без соответствующей обработки данных. Для этого была разработана специальная 
методика расчета компенсации потери металла при эрозийных поражениях. 

7.4 Универсальная точность (Зависит от периодичности фиксации 
замеров) 

� Равномерная коррозия: Обычно +/- 0,03% от величины ТС - при снятии одного замера в 
час (питание от сети). 
� Равномерная коррозия: Обычно +/- 0,1% от величины  ТС  - при снятии одного замера в 
день (питание от батареи). 
� Равномерная коррозия: Обычно  +/- 0,5% от величины ТС  для FSM-IT (нет питания). 
� Питтинговая коррозия: Обычно +/- 0,5% от величины ТС (питание от сети). 
� Коррозия вершины сварочного шва: Обычно +/- 0,2% от величины ТС (питание от сети). 
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� Эрозия на сгибах: Обычно +/- 0,2% от величины ТС (питание от сети). 

ТС:  ТОЛЩИНА СТЕНКИ 
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7.5      Абсолютная точность 

� Равномерная коррозия: Обычно +/- -0,03% от величины ТС (питание от сети). 
� Равномерная коррозия: Обычно +/- -0,1% от величины ТС (питание от батареи). 
� Питинговая коррозия: Обычно +/-20% от глубины эрозионной язвы (неглуб. язвы; 
питание от батареи). 
� Коррозия вершины сварочного шва: Обычно +/-10% от глубины борозды (неглуб. 
борозды; питание от батареи). 
� Эрозия на сгибах: Обычно +/-20% глубины эрозии. 

ТС: WALL THICKNESS/ ТОЛЩИНА СТЕНКИ 

8 УПРАВЛЕНИЕ ИЗМЕРИТЕЛЬНЫМ ПРИБОРОМ FSM В ПО 
MULTITREND 

8.1      Совместное использование ПО MultiTrend с установкой FSM G4 

В данном разделе описывается настройка установки FSM G4. 

8.1.1 Создание конфигурационного файла MultiTrend 

Для создания чистого конфигурационного файла, выберите пункт меню File->New. Укажите 
подходящее имя файла, например "FSM Installation", так, чтобы его потом легко можно было 
найти. 

8.1.2   Добавление интерфейса последовательного соединения 

Для подключения через COM-порт, система MultiTrend должна быть настроена на 
последовательный интерфейс взаимодействия. 
Выберите пункт меню Edit->New->Interface,   как показано на рисунке 129129(или  New-
>Interface 
из контекстного меню). 

 

Рисунок 129129 Создание интерфейса 

Открывается окно выбора интерфейса, показанное на Рисунке 130130. Выберите Serial 
(Последовательный), и нажмите кнопку Next> . 
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Рисунок 130130 Окно выбора интерфейса 

 

Рисунок 131131 Окно конфигурации  порта 

Теперь в Окне Instrument View содержится значок, соответствующий новому 
последовательному интерфейсу (См. Рисунок 132132). Выберите этот значок и перейдите на 
вкладку настройки в окне Подробной информации. Выберите скорость передачи данных, 
руководствуясь документацией датчика. В большинстве случаев, для остальных параметров 
можно оставить значения по умолчанию. 

Рисунок 132132 Установка свойств 
последовательного порта 

 

Выберите 
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вами 
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Выберите вкладку 
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интерфейс 
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датчика, 
выберите 



CorrOcean ASA РЕД: 04 
РУКОВОДСТВО ПОЛЬЗОВАТЕЛЯ СИСТЕМЫ MULTITREND Страница:

 106 из125 
Документ №:    4174-16959-I-MU-0003 Дата: 03.10.04 
 
Добавление Измерительного прибора G4  8.1.3 

Для того, чтобы добавить новый измерительный прибор, выберите пункт меню Edit->New-
>Instrument, как показано на рисунке 133133.  Откроется диалоговое окно для нового прибора, 
показанное на рисунке 134134. Из списка выберите тип прибора FSMStation G4 , а затем 
введите название в поле Tag (Идентификатор). Также, можно использовать установку G4 с 
головным модулем системы FieldBus. Настройка головного модуля описана в разделе 5.6.2.3. 
 

Рисунок 133133 Меню добавления 
нового измерительного прибора 

Рисунок 134134 Диалоговое Окно для 
создания нового прибора 

После завершения вышеописанных шагов, древовидная структура конфигурации в окне 
Instrument View должна выглядеть, как показано на Рисунке 135135. Если используется 
головной модуль FieldBus, то на вкладке "address" (окно подробной информации), нужно 

указать соответствующий адрес. 

 
Рисунок 135135 Измерительный прибор добавлен в конфигурацию 
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8.1.4   Добавление матрицы 

Щелкните правой кнопкой по прибору и выберите пункт New->Matrix->FSM Pin Matrix. 
 

Рисунок 136136 Диалоговое окно создания новой 
матрицы FSM  

Рисунок 137137 Диалоговое окно настройки 
параметров новой матрицы FSM 

Откроется мастер установки матрицы, Рисунок 136136; необходимо ввести идентификатор 
матрицы. По завершению нажмите кнопку Next. В окне установки параметров, для 
температурных датчиков следует оставить значения, предложенные по-умолчанию, если иное 
не указано в документации; укажите частоту локальной электросети, соответствующей 
источнику питания в зоне монтажа.Нажмите кнопку FSM Pin Matrix Editor (Редактор контактной 
матрицы). Откроется редактор матрицы FSM с пустой конфигурацией; макет матрицы задается 
вручную, с использованием документации, либо, как вариант, путем импортирования 
имеющегося шаблона. В данном примере конфигурация импортируется из шаблона 
"64Pins_G4", расположенного в разделе "FSM Matrix Templates" на усатновочном CD-диске 
MultiTrend . Конфигурация для прибора G4 с 64 контактами показана на Рисунке 138138. Для 

того, чтобы импортировать файл шаблона, выберите пункт меню File ->Open Template, далее, 
выберите файл  "64Pins_G4"  с установочного диска, и, наконец сохраните загруженную 
настройку. Закройте редактор матрицы. 

 
Рисунок 138138 Конфигурация прибора G4 с 64 контактами 
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Устанавливать параметры в последнем диалоговом окне мастера, Рисунок 139139, 
можно по желанию. По окончанию нажмите кнопку Finish. 

 

Рисунок 139139 Диалоговое окно задания параметров новой матрицы FSM 

Все необходимые для создания конфигурации пункты выполнены, схема настройки должна 
выглядеть, как показано на рисунке 140140 

Рисунок 140140 Окончательная 
настройка прибора 
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8.1.5   Конфигурирование установки 

Из древовидной структуры выберите измерительный прибор FSM; в окне подробной 
информации появится набор вкладок, содержащий разделы, показанные на рисунке 141141 

 
Рисунок 141141 Набор вкладок 

Более подробную информацию по различным диалоговым окнам настройки прибора можно 
найти в разделе  8.2 Диалоговые окна настройки прибора G4. Для того, чтобы проверить, 
правильно ли подключен прибор, выберите вкладку Status Details и нажмите кнопку “Get From 
Instrument”. Если все работает корректно, в окне журнала появится информация о прогрессе и 
состоянии устройства. Кроме того, появятся данные в текстовых полях диалогового окна. 

В данном примере мы проверим установочные параметры, загруженные из шаблона. 
В диалоговом окне прибора, выберите пункт Matrix.  Более подробную информацию по 
различным диалоговым окнам настройки матрицы можно найти в разделе 8.4 Диалоговые окна 
настройки матрицы FSM. Открыв редактор матрицы контактов, убедитесь, что схема содержит 
64 контакта, расположенных последовательно поверх 8 АЦП (Причем последняя пара на всех 
АЦП является длинной парой, состоящей из 1-го контакта первой пары и последнего контакта 
7-й пары). Откройте диалоговое окно Current Feeds и проверьте, что все параметры 
соответствуют нижеперечисленным в таблице 11. 

 

Ист-к питания номер 1 1 
Напряжение возбуждения 18V 
Ширина импульса 1700 мс 
Время стабилизации 1000 мс 
Среднее измерение 1 

Таблица 11 Параметры тока возбуждения 

Закройте редактор матрицы. 

Откройте диалоговое окно Advanced command (Расширенные команды) в окне команд 
измерительного прибора. 
Нажмите кнопку Send Pin Configuration. (Система MultiTrend должна работать в расширенном 
режиме) 
 Закройте окно по завершению передачи. 

8.1.5.1 Конфигурирование автоматической регистрации 
Есть два варианта активации регистрации в системе; 
Первый способ - настроить измерительный прибор на осуществление замеров через 
установленные промежутки времени. Второй способ - настроить  MultiTrend на автоматический 
запуск регистрации при получении  результатов замеров в онлайновом режиме. 

Лучше всего воспользоваться первым способом, так как, если система MultiTrend потеряет 
контакт с измерительным прибором на какой-то период времени, то регистрацию продолжит 
измерительный прибор. При использовании второго способа это невозможно. 

Для активации режима замеров, инициируемых прибором, нажмите кнопку Change на вкладке 
Команды диалогового окна подробной информации по прибору, Рисунок 143143. Далее, 
выберите интервал и установите переключатель в положение ON. С этого момента 
измерительный прибор будет осуществлять замеры через установленные интервалы времени. 

8.1.5.2 Конфигурирование автоматического приема данных 
В окне Команды измерительного прибора, укажите желаемый интервал автоматического 
приема данных. Снимите галочку с пункта “Measure before Retrieve” (Измерять перед 
получением). Установите переключатель в положение ON. ПРИМЕЧАНИЕ: Для 
автоматического приема данных, система MultiTrend должна находиться в онлайновом режиме. 
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8.1.5.3 Ручной запуск замеров 
Для запуска замеров вручную, откройте вкладку Команды диалогового окна подробной 
информации по прибору, нажмите кнопку Advanced Commands. В открывшемся диалоговом 
окне можно вручную запустить процесс осуществления замеров. Данная функция доступна в 
сервисном режиме, а также в расширенном сервисном режиме. 

8.1.5.4 Ручной прием результатов замеров 
Для получения результата замера вручную, откройте вкладку Команды диалогового окна 
подробной информации по прибору, затем нажмите кнопку "retrieve".Если пункт "measure before 
retrieve" отмечен галочкой, то измерительный прибор произведет замер перед передачей 
данных. 

8.2      Диалоговое окно подробной информации по прибору G4 

8.2.1 Диалоговое окно описания 

Диалоговое окно описания предназначено для хранения общей информации о приборе 
(вводится пользователем). Доступно для редактирования только в сервисном режиме , а также 
в расширенном сервисном режиме. 

8.2.2 Информационное диалоговое окно  

В информационном окне вводится серийный номер, номер заказа, информация о 
производителе, а также дата монтажа. Доступно для редактирования только в сервисном 
режиме , а также в расширенном сервисном режиме. 

8.2.3 Адресное диалоговое окно 

В адресном окне, Рисунок 142142, указываются адрес регистратора, а также Аналого-
Цифрового преобразователя.Доступно для редактирования только в сервисном режиме , а 
также в расширенном сервисном режиме. 

 

Рисунок 142142 Диалоговое окно адреса 
прибора 

Рисунок 143143 Диалоговое окно команд 
измерительного прибора 
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8.2.4 Диалоговое окно для ввода команд  

В данном диалоговом окне (Рисунок 143143) размещены настройки конфигурирования 
измерительного прибора. 

Automatic Measure (Автоматический замер): Измерительный прибор настроен на 
автоматический съем замеров; опция доступна  в сервисном режиме, а также в расширенном 
сервисном режиме. 

Automatic retrieve (Автоматический прием данных): MultiTrend настроен на автоматический 
прием данных; опция доступна  в сервисном режиме, а также в расширенном сервисном 
режиме.  

Measure before retrieve (Измерение перед приемом данных) : осуществление замеров 
активируется в системе MultiTrend перед автоматическим приемом данных ; опция доступна  в 
сервисном режиме, а также в расширенном сервисном режиме.  

Apply to all loggers (Применить ко всем регистраторам): Устанавливает текущие настройки 
для всех физически подключенных регистраторов (Обычно применяется при использовании 
множества регистраторов при головном модуле FieldBus) ; опция доступна  в сервисном 
режиме, а также в расширенном сервисном режиме. 

8.2.5 Расширенные команды 

Кнопка Advanced commands открывает диалоговое окно Команд Интерактивного Регистратора 
(Interactive Logger Commands), рисунок 144144;  опция доступна  в сервисном режиме, а также 
в расширенном сервисном режиме. В сервисном режиме доступны только следующие 
команды:Начать замер, Снять метку и Останов регистратора. 

 
Рисунок 144144 Интерактивные команды регистратора 

В Расширенном режиме доступны все параметры и команды. К новым параметрам и командам 
относятся: 

� Название регистратора: Параметр используется для указания наименования 
установки. Обычно, в качестве имени указывают расположение установки. 

�  Communication frame size (Размер блока данных при коммуниакации): Значение 
определяет макисмальный размер передаваемого блока данных. Обычно данная 
величина равна 1024 байтам (максимальное значение), если в системе передачи 
данных не требуется использовать блоки  меньшего размера. Также, при зашумленных 
каналах связи, это значение можно уменьшить, чтобы по возможности сократить 
количество повторных попыток передачи (так как ниже вероятность повреждения 
меньших блоков данных). Минимально допустимый размер блока данных составляет  
10 байт. 
Обратите внимание! Если связь с регистрирующим устройством осуществляется через 
головной модуль CorrOcean Field Bus, то обязательно используется размер блока 
данных в 1024 байта. 



CorrOcean ASA РЕД: 04 
РУКОВОДСТВО ПОЛЬЗОВАТЕЛЯ СИСТЕМЫ MULTITREND Страница:

 112 из125 
Документ №:    4174-16959-I-MU-0003 Дата: 03.10.04 
 

� Character receivable timeout (Время простоя между приемами данных): Эта величина 
определяет, сколько времени (в миллисекундах) установка ожидает поступления 
нового символа, после приема предыдущего. Для обычных установок G4 это значение 
не изменяется. 

� Battery limit (Предел питания от батареи): Устанавливает уровень напряжения, при 
котором прибор переходит в аварийный режим (в случае, когда напряжение ниже 
установленного предела). 
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� Wakeup acknowledge (Подтверждение активации): Этот параметр включает или 
выключает посыл подтверждения активации установки FSM при получении ею сигнала 
об установлении связи. 

� Battery Burning (Прогрев батареи): Этот параметр определяет, должна ли установка 
производить прогрев батарей при переходе в активный режим для определения уровня 
питания. Если опция выбрана, прогрев батарей будет осуществляться. (Обычно не 
используется). 

� A/D error/timeout (Ошибка/простой АЦП) : указывает на наличие неисправностей в АЦП 
установки FSM. 
� Station ID/address/location (Идентификатор/адрес/местоположение установки): В этих 

параметрах хранится информация об идентификаторе и  местоположении установки. 
Параметр Station ID  (Идентификатор установки) определяет уникальный номер для 
идентификации установки. Параметр Address используется, если установка 
подсоединена к какой-либо коммуникационной шине (как например, шина рабочей зоны 
(field bus), и обозначает адрес установки в шине. Параметр  
Location (Местоположение) может использоваться для указания номера установки в 
конкретной зоне. 

�  Broadcast (Трансляция): Если адрес узла, соответствующего установке FSM, 
неизвестен, то для осуществления связи может использоваться режим трансляции. 
Никакие другие устройства не должны подключаться к шине, если используется режим 
трансляции. 

�  Start measurement (Начать замер): При получении этой команды, установка FSM 
произведет операцию замера. Данные замера будут сохранены во внутренней памяти 
установки, и затем могут быть получены при помощи команд приема данных.. Во время 
осуществления замера (это может занять несколько минут), установка не будет 
реагировать ни на какие другие команды, отправляемые ей в это время. 

�  Delete measurements (Удалить данные замеров): Получив эту команду, установка 
FSM произведет удаление их внутренних буферов всех данных, которые уже были 
успешно переданы в систему MultiTrend. 

�  Unmark Measurements (Снять метку замеров):  Получив эту команду, установка FSM 
снимет со всех внутренних буферов метку (обозначающую, что данные замеров были 
успешно переданы). Эту команду можно использовать, чтобы установка FSM передала 
все данные из внутренних буферов во время следующего сеанса передачи данных, 
даже если они были успешно отправлены ранее. 

� Logger Reset (Перезагрузка регистрирующего устройства): Эта команда производит 
перезапуск установки FSM. Все храниемые ею данные замеров будут удалены, а все 
параметры будут установлены в позицию "по-умолчанию". Если имеется неполадка в 
энергонезависимом ОЗУ (NVRAM), систему необходимо перезапустить. 

� Logger Shutdown (Останов регистрирующего устройства): Эта команда переводит 
установку FSM в режим ожидания. Установка FSM переходит в режим ожидания 
автоматически после определенного интервала неактивности коммуникационного 
канала (зависит от используемой коммуникационной системы). 

� Leave Emergency mode (Выйти из аварийного режима ): Эта команда сбрасывает все 
внутренние флаги ошибки установки  FSM. 
Это единственный способ вывода установки FSM из аварийного режима. В аварийном 
режиме, установка FSM не принимает никаких команд, кроме этой. 

� Get Pin Configuration (Получить конфигурацию контактов): Запрашивает конфигурацию 
контактов с установки и открывает редактор матрицы, в котором отборажается данная 
конфигурация. 

� Send Pin Configuration (Переслать конфигурацию контактов): Отправляет 
конфигурацию контактов из системы MultiTrend к установке. 

8.2.6   Опции настройки связи 

Кнопка Communication options открывает диалоговое окно расширенной настройки 
регистратора (Advanced Logger setup), рисунок 145145;  опция доступна  в сервисном режиме, а 
также в расширенном сервисном режиме. В сервисном режиме все параметры доступны только 
для чтения: 
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Рисунок 145145 Расширенная настройка регистратора 

В расширенном режиме, для редактирования доступны следующие параметры: 

�  Delay between commands (Задержка между командами): Временной интервал в 
миллисекундах. Значение по умолчанию “0”. 
� Number of command retries (Количество повторных попыток): Определяет, сколько 

попыток посыла команды выполняет MultiTrend перед установкой флага ошибки. 
Значение по умолчанию “10”. 

� Delay before command retries (Задержка между повторами): Временной интервал в 
миллисекундах. Значение по умолчанию “3500”. 
� Retrieve failures before logger reset (Число неудачных попыток получения данных 

перед перезапуском регистратора) : MultiTrend предпримет попытку перезапуска 
регистратора, если происходит обрыв связи на удачных попытках. Значение по 
умолчанию “20”. 

� Clear Logger Memory After Retrieval (Очистить память регистратора после передачи 
данных): Удаляет данные замеров в регистрирующем устройстве; 
команда "снять метку" недоступна, если выбрана данная опция. 

� Stop Retrieval After Failed Reset (Остановить прием данных после неудачной 
попытки перезапуска): Если регистрирующее устройство не отвечает после 
автоматической перезагрузки, система 
MultiTrend отключает функцию автоматического приема данных. 

8.2.7   Диалоговое окно состояния (Status Details) 

В данном окне отображается общая информация по регистрирующему устройству.Получение 
информации осуществляется при помощи команды "Get From Instrument".  

 
Рисунок 146146 Окно информации о состоянии измерительного прибора 
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8.3 Вспомогательные датчики FSM G4 

В приборе  FSM G4 имеется один вспомогательный датчик, содержащий служебные данные. 
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Рисунок 147147 Служебный датчик 

8.4      Диалоговые окна подробной информации по матрице установки FSM 

8.4.1    Диалоговое окно Расчеты (Calculations) 

В этом диалоговом окне, рисунок 148148, можно найти информацию о замерах. 
.    Raw Value 
 (Исходное значение): Показывает исходное значение для выбранной пары. Для выбора 
другой пары, нажмите кнопку  

F>> , чтобы открыть окно с формулой.Здесь показаны все контактные пары матрицы 
. В одно и то же время можно просматривать только одну пару..     Значение FC: 

Показывает рассчитанное значение FC для одной парыr.  Для выбора другой пары 
откройте окно  формулы. 

Здесь показаны все контактные пары матрицы.В одно и то же время можно 
просматривать только одну  
пару..     Metalloss (Потеря металла): Отображает Расчетное значение общей потери 

металла, основанное на показателях всех контактных пар. Доступные варианты расчета 
представлены 

в диалоговом окне формулы. Возможные варианты: Среднее значение, Медиана, 
Максимум, Минимум. .    Интенсивность коррозии: Показывает интенсивность, 
рассчитанную на основе показателя потери металла. Установка интервала интеграции 
значений 

производится в диалоговом окне формулы. 

Для всех сигналов в диалоговом окне расчетов, доступны следующие функции: 

 Отображает значение по датчику в окне состояния, 

если отмечено галочкой.  Отображает настройки 

 

Служебный датчик: 

 Рисунок 148148 Диалоговое окно Расчетов по  матрице 
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Контроля\Аварийных сигналов.  Отображает данные в табличном 

формате. .    Отображает данные в виде двухмерной диаграммы. 
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8.4.2 Диалоговое окно описания 

Диалоговое окно описания предназначено для хранения общей информации о приборе 
(вводится пользователем). Доступно для редактирования только в сервисном режиме , а также 
в расширенном сервисном режиме. 
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8.4.3   Диалоговое окно параметров 

Диалоговое окно параметров, Рисунок 149149, содержит информацию по матрице. 
� Matrix Temperature Sensors (Температурные датчики матрицы): Количество 

температурных датчиков матрицы (физическое). 
� Local Power Grid Frequency (Частота локальной электросети) : Укажите частоту 
электросети в зоне установки оборудования. 

Информация о количестве контактов, контактных пар и источников подачи тока на матрицу 
находится в разделе "Pin configuration" (Конфигурация контактов). Редактор матрицы контактов 
можно запустить из этого диалогового окна. 

 
Рисунок 149149 Диалоговое окно Расчетов по  матрице 

8.4.4 Информационное диалоговое окно 

В информационном окне вводится серийный номер, номер заказа, информация о 
производителе, а также дата монтажа. Доступно для редактирования только в сервисном 
режиме , а также в расширенном сервисном режиме. 

8.4.5 Диалоговое окно для ввода команд 

Данное диалоговое окно содержит ряд кнопок, соответствующих следующим функциям: 
�  Manual Measurement (Ручной замер): Используется для ручного ввода результата 

замера в базу данных - используется в испытательных целях 
� Select signature (Выбор характеристики эл.поля): Выберите имеющуюся или создайте 

новую характеристику эл.поля, которая будет использоваться при расчете итоговых 
величин FSM. В диалоговом окне нужно ввести временной интервал для расчета 
характеристики эл.поля. 

�  FSM Pin Matrix Editor (Редактор матрицы контактов FSM): Запустите редактор матрицы 
контактов, чтобы сконфигурировать ее нужным образом. 

� Edit Raw Data (Редактировать исходные данные): Отредактировать существующие 
исходны данные в базе данных. 
� Data Compression (Сжатие данных): Открывает диалоговое окно 

функции сжатия базы данных. 
Вспомогательные датчики матрицы G4 
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8.4.6    Вспомогательные датчики матрицы 

Матрица установки  G4 снабжена двумя 
вспомогательными датчиками �     
Служебный датчик 

 

Рисунок 150150 Обслуживание матрицы 

�     Температурный датчик 
 

Рисунок 151151 Температуры матрицы 

8.5      Использование системы MultiTrend совместно с измерительным 
прибором FSM IT  

В данном разделе описывается, как настроить измерительный прибор  FSM IT для совместной 
работы с ПО MultiTrend 

8.5.1 Создание конфигурационного файла MultiTrend 

Для создания чистого конфигурационного файла, выберите пункт меню File->New. Укажите 
подходящее имя файла, например "FSM Installation", так, чтобы его потом легко можно было 
найти. 

8.5.2   Добавление интерфейса последовательного соединения 

Для подключения через COM-порт, система MultiTrend должна быть настроена на 
последовательный интерфейс взаимодйствия. 
Выберите пункт меню Edit->New->Interface,   как показано на рисунке 152152(или  New-
>Interface 
из контекстного меню). 

 

Рисунок 152152 Создание интерфейса 

Открывается окно выбора интерфейса, показанное на Рисунке 153153. Выберите Serial 
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(Последовательный), и нажмите кнопку Next> . 
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Рисунок 153153 Окно выбора интерфейса 

 

Рисунок 154154 Окно конфигурации  порта 

Теперь в окне Instrument View содержится значок, соответствующий новому 
последовательному интерфейсу (См. Рисунок 155155) Выберите значок и выберите вкладку 
Настройка (Setup) в окне информации. Выберите скорость передачи данных равную 38400. 

Рисунок 155155 Установка свойств последовательного порта 

8.5.3   Добавление измерительного прибора  FSM IT  

Для того, чтобы добавить новый измерительный прибор, выберите пункт меню Edit->New-
>Instrument, как показано на рисунке 156156.  Откроется диалоговое окно для нового прибора, 
показанное на рисунке 157157. Из списка выберите тип прибора FSM IT Instrument, а затем 
введите название в поле Tag (Идентификатор). 

 

Выберите 
нужный тип 
интерфейса Нажмите  

Next для 
продолжения 

 

Нажмите кнопку 
Finish для 
завершения 
создания 
интерфейса 

Если 
используемый 

вами 
последовательны

 

Выберите вкладку 
настроек (setup), 
чтобы открыть 
настройки 

Выберите новый 
интерфейс 

чтобы открыть 
окно с подробной 

Руководствуясь 
документацией 
датчика, 
выберите 
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Рисунок 156156 Меню добавления 
нового измерительного прибора Рисунок 157157 Диалоговое Окно для 

создания нового прибора 

После завершения вышеописанных шагов, древовидная структура конфигурации в окне 
Instrument View должна выглядеть, как показано на Рисунке 158158. 

 
Рисунок 158158 Измерительный прибор добавлен в конфигурацию 

8.5.4   Добавление матрицы 

Щелкните правой кнопкой по прибору и выберите пункт New->Matrix->FSM Pin Matrix. 
 

Рисунок 159159 Диалоговое окно создания новой 
матрицы FSM 

Рисунок 160160 Диалоговое окно настройки 
параметров новой матрицы FSM 
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Откроется мастер установки матрицы, Рисунок 159159; необходимо ввести идентификатор 
матрицы. По завершению нажмите кнопку Next. В окне установки параметров, для 
температурных датчиков следует оставить значения, предложенные по-умолчанию, если иное 
не указано в документации; укажите частоту локальной электросети, соответствующей 
источнику питания в зоне монтажа. Нажмите кнопку FSM Pin Matrix Editor для установки 
конфигурации матрицы. Откроется редактор матрицы FSM с пустой конфигурацией; макет 
матрицы задается вручную, с использованием документации, либо, как вариант, путем 
импортирования имеющегося шаблона. В данном примере конфигурация задается на основе 
записей.Более подробную информацию см. в руководстве пользователя измерительного 
прибора FSM IT. 

8.5.5   Конфигурирование матрицы 

Для конфигурирования матрицы, система MultiTrend должна работать в расширенном 
сервисном режиме. Настройка конфигурации матрицы состоит из двух списков, в одном из 
которых перечислены контакты, а в другом - вспомогательные матрицы, отражающие 
аппаратное подключение к ИМД (Интерфейсу матрицы датчиков).(Один ИМД считается 
вспомогательной матрицей). Добавьте контакты из общего списка, выбирая соответствующие 
ИМД, а затем контакты.Контактны будут последовательно добавляться парами; при выборе 
контактов, можно пользоваться стандартными функциями windows (исп-е клавиш shift или ctrl, 
для выбора сразу нескольких элементов). 

Добавьте в конфигурацию 56 контактов, указав в поле "pins" число 55, и нажмите кнопку . 
В конфигурацию добавлено 56 контактов. 

 

Рисунок 161161 Конфигурация матрицы FSMIT  

Теперь добавьте две вспомогательные матрицы, дважды нажав кнопку .В списке 
вспомогательных матриц должны появиться SMI 01 и SMI 02 
. 
Последовательно добавьте первые 28 контактов, выбрав спом. матрицу SMI 01, затем 
выберите  pin1 в списке контактов, нажмите 
shift и выберите pin28. Нажмите кнопку , чтобы назначить выбранные 
контакты соответствующей матрице SMI 01. Аналогично, назначьте матрице 
SMI 02 контакты с 29 по 56. 
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Выберите вкладку  Current feed (Подача питания), Рисунок 162162, и выберите пункт Current 
feed 1 из списка. 

 

Рисунок 163163 Параметры новой матрицы 
FSM 

Рисунок 162162 Подача питания на 
матрицу 

Поставьте галочку напротив пункта Set Current Automatically, чтобы прибор FSM IT 
автоматически рассчитывал уровень тока после получения настроек. (Следует 
перезапустить прибор, либо присвоить ему новый идентификатор, чтобы выполнить 
этот расчет). Для остальных параметров оставьте значения по-умолчанию. 

Сохраните конфигурацию, выбрав пункт меню "save", а затем закройте редактор 
конфигурации контактов. 

Далее, вы вернетесь в мастер настройки новой матрицы. 
Устанавливать параметры в последнем диалоговом окне мастера, Рисунок 163163, можно 
по желанию. Нажмите Finish 
по завершению. 

После всех этих этапов, конфигурация должна выглядеть следующим образом, Рисунок 
164164. 
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Рисунок 164164 Окончательная настройка прибора 
 

Измерит
ельный 

Матрица 

Окно 
подроб
ной 



CorrOcean ASA РЕД: 04 
РУКОВОДСТВО ПОЛЬЗОВАТЕЛЯ СИСТЕМЫ MULTITREND Страница:

 127 из125 
Документ №:    4174-16959-I-MU-0003 Дата: 03.10.04 
 
8.5.5.1  Конфигурирование адресов SMI (ИМД) 
Для того, чтобы прибор FSM IT мог распознать матрицу, нужно ввести соответствующие адреса 
ИМД: 
адрес для каждого ИМД + адрес контрольного ИМД - эту информацию можно найти в 
документации. Кроме того, адрес ИМД 
можно найти непосредственно на физическом ИМД. 
Диалоговое окно настройки адреса можно открыть из окна подробной информации по матрице, 
рисунок 165165. 
Введите соответствующие адреса ИМД. 

 
Рисунок 165165 Диалоговое окно настройки адреса ИМД 

8.5.5.2 Передача настроек измерительному прибору 
Измерительный прибор должен быть подключен к последовательному порту; включите питание 
прибора FSM IT, нажав на сенсорный экран. Выберите прибор FSM IT в системе MultiTrend, 
если он уже использовался в различных рабочих зонах. Далее, нажмите кнопку "advanced 
commands" (расширенные команды) в диалоговом окне ввода команд. В этом диалоговом окне 
нажмите кнопку Clean Sites (Очистить рабочие зоны). Закройте активное диалоговое окно и 
нажмите кнопку Send Setup (Отправить настройки). 

8.5.5.3 Настройка таймера измерительного прибора 
Для синхронизации внутреннего таймера измерительного прибора с таймером ПК, из окна 
подробной информации откройте диалоговое окно Состояние (Status), далее нажмите кнопку 
"synchronise" (синхронизировать). 

8.5.5.4 Запуск процесса снятия замеров из системы MultiTrend 

Кнопка "Start measurement" (Запуск замеров) находится в диалоговом 

окне "advanced commands" (расширенные команды). 

8.5.5.5 Прием данных замеров  Эта операция выполняется 

из диалогового окна "commands" (команды). 



CorrOcean ASA РЕД: 04 
РУКОВОДСТВО ПОЛЬЗОВАТЕЛЯ СИСТЕМЫ MULTITREND Страница:

 128 из125 
Документ №:    4174-16959-I-MU-0003 Дата: 03.10.04 
 
8.6      Диалоговые окна подробной информации по измерительному 
прибору FSM IT 

8.6.1 Диалоговое окно описания 

Диалоговое окно описания предназначено для хранения общей информации о приборе 
(вводится пользователем). Доступно для редактирования только в сервисном режиме , а также 
в расширенном сервисном режиме. 

8.6.2 Информационное диалоговое окно 

В информационном окне вводится серийный номер, номер заказа, информация о 
производителе, а также дата монтажа. Доступно для редактирования только в сервисном 
режиме , а также в расширенном сервисном режиме. 

8.6.3 Адресное диалоговое окно 

В адресном диалоговом окне, рисунок  166166, представлен адрес контрольного ИМД системы 
FSM. Для определения, к какой матрице физически подключен Прибор FSM IT, используется 
серийный номер контрольного ИМД. Параметры, которые нельзя менять в данном диалоговом 
окне, можно настраивать из диалогового окна матрицы. 

 

Рисунок 166166 Диалог адреса прибора 
FSM IT 

Рисунок 167167 Диалог команд прибора FSM 
IT 

8.6.4 Диалоговое окно для ввода команд 

В окне команд, рисунок 167167, можно осуществлять настройку прибора, а также посыл команд. 

Automatic Measure (Автоматический замер): Функция недоступна в настоящий момент. 

Automatic retrieve (Автоматический прием данных): MultiTrend настроен на автоматический 
прием данных; опция доступна  в сервисном режиме, а также в расширенном сервисном режиме. 

Measure before retrieve (Измерение перед приемом данных) : осуществление замеров 
активируется в системе MultiTrend перед автоматическим приемом данных ; опция доступна  в 
сервисном режиме, а также в расширенном сервисном режиме. 

Apply to all loggers (Применить ко всем регистраторам): Не используется для измерительных 
приборов FSM IT 
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8.6.5 Расширенные команды 

Окно расширенных команд, рисунок 168168, состоит из двух древовидных окон, 
где представлены файлы и папки локального компьютера и подсоединенного прибора FSM IT  
. 
Стрелки между этими окнами предназначены для копирования файлов в прибор и с него. 
 

 
Рисунок 168168 Диалоговое окно расширенных команд прибора FSM IT 

�  Start measurement (Начать замер): Измерительный прибор FSM IT начинает 
осуществлять замеры. 
Перед посылом данной команды, убедитесь, что прибор включен. 

�  Shutdown  (Останов): Система MultiTrend производит останов прибора 
�  Clean sites (Очистить рабочие зоны): Очистить все матрицы, сконфигурированные в 
приборе. 
� View (Просмотр): Просмотреть текстовые файлы, или файлы "bbn" 

8.6.6   Опции настройки связи 

Кнопка Communication options открывает диалоговое окно расширенной настройки 
регистратора (Advanced Logger setup);  опция доступна  в сервисном режиме, а также в 
расширенном сервисном режиме. В сервисном режиме все параметры доступны только для 
чтения: 
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Рисунок 169169 Расширенная настройка регистратора 

В расширенном режиме, для редактирования доступны следующие параметры: 

�  Delay between commands (Задержка между командами): Временной интервал в 
миллисекундах. Значение по умолчанию “0”. 
� Number of command retries (Количество повторных попыток):   Определяет, сколько 

попыток посыла команды выполняет MultiTrend перед установкой флага ошибки. 
Значение по умолчанию “10”. 

� Delay before command retries (Задержка между повторами): Временной интервал в 
миллисекундах. Значение по умолчанию “3500”. 
� Retrieve failures before logger reset (Число неудачных попыток получения данных 

перед перезапуском регистратора) : MultiTrend предпримет попытку перезапуска 
регистратора, если происходит обрыв связи на удачных попытках. Значение по 
умолчанию “20”. 

� Clear Logger Memory After Retrieval (Очистить память регистратора после передачи 
данных): Удаляет данные замеров в регистрирующем устройстве; команда "снять 
метку" недоступна, если выбрана данная опция. 

� Stop Retrieval After Failed Reset (Остановить прием данных после неудачной 
попытки перезапуска): Если регистрирующее устройство не отвечает после 
автоматической перезагрузки, система 
MultiTrend отключает функцию автоматического приема данных. 

8.7 Диалоговые окна подробной информации по матрице FSM IT 

Доступны те же опции, что и описанные для матрицы G4 в разделе 8.4, за исключением 
доплнительного адресного поля, где указывется адрес ИМД. (Описывается в разделе 8.5.5.1) 

8.8 Вспомогательные датчики матрицы FSM IT  

Матрица FSM IT снабжена двумя вспомогательными датчиками 

� Обслуживающий датчик 
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�     Температурный датчик 
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9       ИМПОРТ КОНФИГУРАЦИЙ FSMTREND 

Есть возможность ипортировать конфигурации системы FSMTrend; диалоговое окно 
импорта данных можно открыть через меню File. Для импортирования установки или 
конфигурации FSMIT, выберите папку, содержащую конфигурацию FSMTrend. 

При выборе такой папки, система MultiTrend отобразит найденные установки, рисунок  170170 
. 
Выберите конфигурации, которые нужно импортировать; одновременно можно импортировать 
несколько. 
Для создания записи в базе данных, в установках конфигурация контактных пар определяется 
на основе общего количества контактных пар. 
Корректное описание контактных пар загружается с физической установки. Для установок FSM 
IT, конфигурация 
отображается корректным образом сразу после импорта. При этом, из старых конфигураций не 
загружается информация о геометрическом расположении измерительных 
приборов. 
Возможен импорт конфигураций FSMTrend версии 1.9 и выше. 

 
Рисунок 170170 Диалоговое окно импорта данных FSMTrend 

10   АНАЛИЗ ДАННЫХ 

10.1   Обработка информации 

FSM является системой контроля потерь металла, позволяющая проихводить измерения с 
точностью до  1/1000 начальной толщины стенок трубы. При подготовке данных к 
интерпретации, можно воспользоваться следующими функциями: 

� Remove zero readings (Удалить нулевые данные замеров), 
� Temperature compensation (Компенсация температуры) 
� FSM-IT averaging (Усреднение) 
� Offset compensation (Компенсация смещений) 
� Creating one metal loss curve from a group of pairs (Воссоздание единой кривой потери 
металла на основе группы контактных пар) 
� Spike control (Контроль пиков) 
� Smoothing filter (Сглаживающий фильтр) 
� Groove analysis (Анализ коррозионных борозд) 
� Local Corrosion Analysis (LCA) (Анализ местной коррозии) 



CorrOcean ASA РЕД: 04 
РУКОВОДСТВО ПОЛЬЗОВАТЕЛЯ СИСТЕМЫ MULTITREND Страница:

 134 из125 
Документ №:    4174-16959-I-MU-0003 Дата: 03.10.04 
 

� Bend erosion compensation (Компенсация эрозии на изгибах) 
� Conversion to preferred output format (Преобразование в иной формат вывода данных) 

MultiTrend выполняет все вычисления, не затрагивая исходные данные.Более подробно см. в 
разделе 10.4. 

10.1.1 Характеристика эл. поля FSM 

Характеристика эл. поля является базовой, контрольной величиной для осуществления 
расчетов по технологии FSM. Все данные замеров отсчитываются относительно данной 
величины.Показатель характеристики эл. поля основывается на серии замеров, 
произведенных при известной толщине стенок трубы, обычно для на новой 
металлоконструкции. Кроме того, определение этого показателя нужно производить, когда 
система полностью настроена и находится в режиме нормального функционирования. 

Характеристку эл. поля нужно замерять повторно при изменении метода осуществления 
замеров, а также при установке новых параметров замера. Делать это не рекомендуется без 
дополнительного контроля со стороны представителей CorrOcean. 

10.2   Отображение и редактирование групп контактных пар на 
двухмерной диаграмме. 

В данном разделе описывается, как получить характеристику эл.поля, а также как добавить и 
отредактировать группы контактных пар. Все действия, которые нужно произвести в программе 
MultiTrend выделены жирным шрифтом. 

10.2.1 Генерация характеристики эл. поля 

Для того, чтобы сгенерировать новую характеристику эл. поля, выберите матрицу и щелкните 
вкладку "commands" в окне подробной информации.См. рисунок 171171. Щелкните кнопку  
'Select Signature >>' . Откроется окно 'Select FSM Signature' (Выбор характеристики эл. поля) 
(рисунок 172172). 

 

Рисунок 171171 Создание новой характеристики 
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Рисунок 172172 Диалоговое окно Создания новой характеристики 

Name (Название) Введите название для новой характеристики. 
Рекомендуется давать информативные названия, включающие дату, время и число замеров 

для 
данной характеристики. При этом будет легче 

оперировать несколькими характеристиками! 
Если вы сгенерировали несколько характеристик, выбрать одну из них можно 

при помощи списка 'Name of signature' (Название характеристики). 

Date & time  (Дата и время)  Укажите дату и время начала и окончания. Количество 
включаемых замеров автоматически обновляется в поле 'No. of meas.' (Кол-во 
замеров). 

Нажмите кнопку  OK ,чтбы сгенерировать характеристику. Нажмите "Cancel" для отмены. 

10.2.2 Двухмерная диаграмма FSM 

Для построения двухмерной диаграммы: 

1. В главном окне выберите матрицу, по которой вы хотите построить диаграмму. Щелкните 
правой кнопкой по матрице, появится контекстное меню, показанное на рисунке 173173. 
Выберите пункт 'XYPlot'. Откроется окно 'FSM data processing setup' (Настройка обработки 
данных FSM) (рисунок  174174). 

2. Выберите группу данных для обработки. 
� Нажмите кнопку  'Signature�' , чтобы выбрать определенную характеристику эл. поля. 
� Нажмите кнопку  'Interval�' , чтобы выбрать интервал данных на обработку.По-

умолчанию обработке подвергаются все данные. 
� Нажмите кнопку 'Setup�' , чтобы рассчитать новые коэффициенты температурной 

компенсации (раздел 
10.4.2). 

� Нажмите кнопку 'Offset correction�' , чтобы добавить или отредактировать 
корректирующие значения смещений (раздел 10.4.4). 
Нажмите 'OK' , чтобы построить диаграмму. Появится окно 'XYPlot' (рисунок  175175). 

3. Для модификации данной диаграммы, добавления новой и т.д.., воспользуйтесь панелью 
инструментов (рисунок  176176). 
4. Для изменения группы данных, по которым произведено построение по осям Y1/Y2, 

выберите 'Graph' и 'Dataset Y1' или 'Dataset Y2'. 
5. Для добавления показателей интенсивности, выберите пункты 'View' и  'Show'. Для того, 

чтобы добавить в таблицу условных обозначений "потерю металла за год", выберите пункт 
'Rates'. Выберите пункт 'Rate graphs' , чтобы добавить график текущей потери металла. 
Можно выбрать отображение информации за последние  7, 10, 30, 60 или 365 дней. 

6. Для выбора единиц измерения оси x, выберите  'View', 'X-axis' и укажите  'Timescale' 
(Временная шкала) или 'Measurement number' (Номер замера). 
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Рисунок 174174 Выберите данные для 
обработки 

Рисунок 173173 Построение 
двухмерной или трехмерной 

 
Рисунок 175175 XYPlot (Двухмерная диаграмма) 
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Рисунок 176176 Панель инструментов двухмерной диаграммы 

10.2.3 Редактировать группы двумерной диаграммы 

Для того, чтобы добавить новую группу данных или настроить параметры существующей, 
воспользуйтесь функцией 'Edit groups' (Редактировать группы). В окне 'FSM data processing 
setup' , поставьте галочку в пункте  'Enable advanced settings' (Рисунок 174174), появится 
кнопка 'Edit groups'. Нажмите кнопку Edit Groups. Появится окно, показанное на Рисунке 
177177. 

 
Рисунок 177177 Диалоговое окно группы 

Нажмите кнопку 'Add', чтобы добавить новую группу. 
Чтобы удалить имеющуюся группу, выберите ее и нажмите кнопку 'Delete'. 
Чтобы поменять свойства имеющейся группы, выберите ее и нажмите кнопку 'Properties'. 
Чтобы сделать копию имеющейся группы, выберите ее и нажмите кнопку 'Insert copy' . 

Если вы хотите добавить новую группу либо поменять свойства имеющейся, см. пункт 10.2.4. 

По завершению нажмите кнопку 'Close' . 
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Рисунок 178178 Опции обработки данных 

При нажатии кнопок  'Add' или  'Properties' в окне, показанном на Рисунке 177177, появится окно  
'Data group properties' (Свойства группы данных) (рисунок  178178). 

В окне 'Selected data' (Выбранные данные) показано, какие контактные пары включены в группу. 
Для того, чтобы выбрать все данные, нажмите кнопку "Add all" (Добавить все). 
Для того, чтобы добавить единственную пару, выберите ее в списке "Available data" 
(Имеющиеся данные) и нажмите кнопку "Add". Также, можно просто 
сделать двойной щелчок на необходимой контактной паре в перечне. 

Для удаления всех выбранных данных, нажмите кнопку "Remove all" (Удалить все). 
Для того, чтобы удалить единственную пару, выберите ее в списке "Selected data" 
(Выбранные данные) и нажмите кнопку "Remove". Также, можно просто 
сделать двойной щелчок на необходимой контактной паре в перечне. 

Опции обработки данных ('Data processing options') описаны в разделе 10.4, а вопросы 
Выходного Формата данных ('Output format') описываются в разделе 10.5. 

10.3   Отображение данных на трехмерной диаграмме 

На трехмерной диаграмме, все контактные пары представлены в соответствии с компоновкой 
матрицы.Построить трехмерный график можно, щелкнув по матрице правой кнопкой мыши и 
выбрав пункт контекстного меню '3D plot' (рисунок  173173). Появится окно 'Options' (Опции) 
(рисунок  179179). 

 

10.2.4 Изменение свойств группы 
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Рисунок 179179: Выбор опций обработки данных для построения трехмерной 
диаграммы 

Опции обработки данных ('Data processing options') 
описаны в разделе 10.4, а вопросы Выходного Формата 
данных ('Output format') описываются в разделе 10.5. 

� Нажмите кнопку  'Signature�' , чтобы выбрать определенную характеристику эл. поля. 
� Нажмите кнопку  'Interval�' , чтобы выбрать интервал данных на обработку.  По-умолчанию 
обработке подвергаются все данные  
. 
� Нажмите кнопку 'Setup�' , чтобы рассчитать новые коэффициенты температурной 
компенсации (раздел 10.4.2). 
� Нажмите кнопку 'Offset correction�' , чтобы добавить или отредактировать корректирующие 
значения смещений (раздел 10.4.4). 

Нажмите 'OK', чтобы построить диаграмму. Появится окно 'FSM3DPlot' (рисунок  181181). 

Выберите пункт меню 'File'-> 'Setup�'  чтобы настроить координатные оси, временные 
интервалы и другие опции обработки данных.. 
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Рисунок 180180: Панель инструментов трехмерной диаграммы 
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Рисунок 181181: Трехмерная диаграмма 

10.4   Описание опций обработки данных 

10.4.1  Remove zero readings (Удаление нулевых значений замеров) 

Если выбрана эта опция, то исходные данные с нулевыми значениями не будут приниматься во 
внимание при расчетах. 

10.4.2   Temperature compensation  (Температурная компенсация) 

10.4.2.1  Влияние температуры на показания системы FSM 

Электрическое сопротивление стали зависит от температуры. Если температура измеряемого 
объекта повышается на 10° C, сопротивление обычно повышается на 3% - 5% в зависимости 
от параметров стали. 

Частично колебания температуры компенсируются контрольной пластиной, изготовленной из 
того же материала, что и сама конструкция. Пластина имеет термосоединение с измерителем, 
но оснащена электроизоляцией.  
Тем не менее, между конструкцией и контрольной пластиной будет определенный 
температурный градиент, что приводит к необходимости использования температурной 
компенсации.Измеряются температуры как самой конструкции, так и контрольной 
пластины.Затем, эти значения используются в алгоритмах температурной компенсации 
системы MultiTrend. 

Данные системы FSM без компенсации будут меняться линейным образом в зависимости от 
разности температур (температурой конструкции и контрольной пластины). Для конструкций из 
углеродистой стали, это отношение составляет примерно 2-3 FC на 1 градус Цельсия. 
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10.4.2.2 Компенсация температурной разности 

Данный метод может компенсировать вариации данных FSM, коррелирующих с изменениями 
температурной разности (температурой конструкции и контрольной пластины). Колебания 
температурной разности - это основаня причина колебаний температуры в данных FSM . 

10.4.2.3 Температурная компенсация секции 

Данный метод используется для компенсации колебаний в данных, связанных с колебаниями 
температуры секции трубопровода.Используется именно в случаях корреляции значений 
замеров с колебаниями температуры секции.Данная ситуация встречается достаточно редко. 

10.4.2.4 Компенсация разности и секционная компенсация 

Этот метод объединяет два вышеназванных метода и может применяться, когда велика 
разность температур секции и контрольной пластины, либо, если материалы, из которых 
изготовлена секция трубопровода и контрольная пластина имеют различные характеристики 
сопротивления. 

10.4.2.5 Использование температурной компенсации 

Рекомендуется вначале использовать метод Компенсации температурной разности (DTC), так 
как именно колебания этой величины играют наибольшую роль в температурных колебаниях 
данных  FSM. Для подбора наиболее оптимального интервала данных (для расчета 
коэффициентов температурной компенсации), можно использовать следующую методику: 

1. Определите взаимосвязь показателей замеров и температурной разности: 
Постройте двухмерную диаграмму для одной группы данных (с настройками 
обработки данных по-умолчанию), и добавьте на нее дополнительную кривую, 
соответствующую температурной разности. Если имеется значительная корреляция 
между данными замеров и температурной разностью, то Метод Компенсации 
температурной разности даст хорошие результаты. 

2. Расчет коэффициентов компенсации температурной разности: В окне 'FSM data 
processing setup' нажмите кнопку 'Setup'(рисунок  174174). Выберите пункт  
'Calculate difference compensation factors... '. Откроется окно 'FSM data interval' 
(Интервал данных FSM). Укажите интервал данных, на основе которого будут 
рассчитываться коэффициенты компенсации. Рекомендуется усанавливать 
сравнительно небольшой интервал  с явной корреляцией данных замеров и 
температурной разности. Подходящим можно назвать интервал, содержащий как 
значительные вариации по температуре, так и стабильные участки. Кроме того, 
интервал должен быть достаточно небольшим, чтобы исключить фактор 
коррозии.Нажмите кнопку ОК. В открывшемся окне 'Select signature', выберите 
характеристику эл. поля. Помните, что характеристика выбирается для условий 
нормальной температуры. (раздел 10.1.1). 

3. В окне 'Data group properties' (Свойства групп данных) активизируйте компенсацию 
температурной разницы (difference temperature compensation) (рисунок  178178). 
Поставьте галочку в пункте ‘Use temperature compensation’ (Использовать 
температурную компенсацию) и нажмите кнопку  'Settings...' (Настройки), чтобы 
открыть окно  'Temperature compensation settings' (Настройка температурной 
компенсации). Убедитесь, что выбран только пункт  ‘Use difference compensation’ 
(Использовать разностную компенсацию) (рисунок  182182). Нажмите кнопку ОК. 
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Рисунок 182182: Выбор типа температурной компенсации 

4. Просмотрите результаты использования компенсации: Постройте новую 
двухмерную диаграмму, щелкнув кнопку 'OK' в окне 'FSM data processing setup 
window' (Настройка обработки данных FSM). В последующих окнах нажимайте 
кнопки  'Close'  и 'OK'. Для сравнения, добавьте температурную разность. 

5. Измените интервал: Повторите шаги со  2 по 4, указав другой интервал (варьируя 
значения "start time" (время начала) и  "width" (ширина)), пока значения замеров не 
перестанут коррелировать с температурной разностью. 

6. Когда уровень компенсации будет удовлетворительным, постройте совместно 
график температуры секции трубопровода и график по скомпенсированным 
показателям.Если наблюдается значительная корреляция, используйте 
комбинированную методику компенсации ( Компенсация разности и секционная 
компенсация ). Для этого потребуется расчет температурных 
коэффициентов.Воспользуйтесь инструкциями пунктаr 2, при этом выбрав 
коэффициенты компенсации температуры секции трубопровода.На вопрос о 
необходимости расчета коэффициентов для комбинированной компенсации 
(calculate compensation factors for combined compensation), ответьте  'Yes' (Да). 
Далее, следуйте указаниям пунктов 3-5; в окне, показанном на рисунке 182182, 
установите обе галочки. 

7. Для того, чтобы использовать раздельную секционную компенсацию, используйте 
ту же последовательность (2-5), как и для температурной разности (соответственно, 
нужно выбирать и опции). Установите галочку в пункте 'Use spool compensation' 
(Использовать секционную компенсацию), как показано на Рисунке 182182. 

10.4.3 FSM IT Data averaging (Усреднение данных FSM IT)  

При использовании измерительных приборов FSM-IT, за раз обычно производятся серии из 3-х 
или более замеров с интервалом 1-2 недели. Колебания в серии результатов замеров не 
имеют особого значения, если они имеют место в долгосрочном периоде.Поэтому, система 
MultiTrend снабжена функцией усреднения данных замеров, расположенных в небольшом 
временном промежутке, и представления их в виде единой величины. 

Для использования данной функции, установите галочку в пункте 'FSMIT data averaging' в окне 
'Data group properties' (Свойства группы данных) (Рисунок 178178). Нажмите кнопку 'Settings' и 
выберите интервал усреднения. Можно устанавливать интервалы в  24 часа, 12 часов, 1 час 
или 15 минут. Этот интервал сохраняется в файле groups.ini file (в секундах), соответственно, 
при необходимости, другие временные интервалы можно устанавливать путем редактирования 
этого файла. 

В качестве отметки времени усредненной величины берется время первого замера в 
серии.Среднее значение рассчитывается путем объединения средних и исключения значений, 
выходящих за рамки. 

10.4.4 Offset compensation  ( Компенсация смещения )  

При замене монтажной платы или установки, может произойти смещение в результатах 
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замеров.Для устранения этого эффекта, можно использовать компенсацию смещения, 
предусмотренную в системе MultiTrend. В системе MultiTrend доступно 3 метода компенсации 
(разделы 10.4.4.1-10.4.4.3). 

Для активации этой функции, отметьте галочкой пункт 'Use Offset compensation' 
(Использовать компенсацию смещения) в окне 'Data group properties' ' (Свойства группы 
данных) (Рисунок 178178).  
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В перечне 'Offset compensation list' (Список компенсаций смещения) определяется, какие из 
видов компенсации актвины. Для того, чтобы отредактировать этот список, нажмите кнопку  
'Offset correction�' в окне 'FSM data processing setup' (Настройка обработки данных FSM'  
(Рисунок 174174). Появится перечень компенсаций смещения (Рисунок 183183). К группе 
данных будут применяться все виды компенсации из перечисленных. 

Нажмите кнопку  'Add offset', чтобы добавить 
новое смещение. Нажмите кнопку  'Edit offset', 
чтобы отредактировать существующее 
смещение. Нажмите кнопку  'Deletet offset', 
чтобы удалить существующее смещение. 

 
Рисунок 183183: Перечень компенсаций смещения 

Если выбрана функция создания нового смещения,  появится окно 'Offset compensation' 
(Компенсация смещения) (Рисунок 184184). Укажите название для нового смещения, 
предпочтительно - с указанием даты и времени. Выберите контактные пары, для которых 
нужно производить компенсацию. Зажмите кнопку  <Ctrl>, чтобы выбрать несколько пар. 
Выберите также используемый метод компенсации, см. разделы (10.4.4.1-10.4.4.3). 

 
Рисунок 184184: Компенсация смещения 

Вне зависимости от выбранного метода компенсации, после нажатия на кнопку 'Next', откроется 
окно ввода начального времени смещения (Рисунок 185185). ПРИМЕЧАНИЕ: Начальное время 
нужно указывать в интервале между предпоследней и последней точками данных (без 
смещения) Обратите внимание! Сюда не включатся отметка времени предпоследней 
точки, но включается  отметка последней). 

Компенсация смещения включает в себя воссоздание новой характеристики эл.поля, а также 
нового уровня отсчета. Расчет характеристики эл. поля осуществляется на основе точек 
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данных после смещения. Их количество определяется пользователем. В случае использования 
автоматической компенсации (раздел10.4.4.1), уровень отсчета определяется 
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на основе данных перед смещением. В данном случае, количество точек данных для расчета 
характеристики эл.поля определяет и количестов замеров, на основе которых рассчитывается 
новый уровень отсчета. 

 
Рисунок 185185: Введите начальную дату и время смещения, а также количество 
замеров для новой характеристики эл.поля. 

10.4.4.1 Automatic Compensation (Автоматическая компенсация) 

Данная методика может использоваться, если невелик показатель потери металла. Новый 
уровень отсчета рассчитывается как медианная величина X последних замеров перед 
смещением. X - количество замеров, используемых для расчета характеристики эл. поля. 

 

Рисунок 186186: Автоматическая компенсация смещения 

10.4.4.2 Manual Compensation (Ручная компенсация) 

Данная методика может использоваться, если невелик показатель потери металла. Новая 
линия отсчета указывается вручную (рисунок 188188). Для каждой пары можно вводить 
различные значения. 

 

Кривая без компенсации 

Смещение 
Кривая с компенсацией 

Медиана 
значений 
по  X 

Перед смещением После смещения 
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Рисунок 187187: Ручная компенсация смещения 

 
Рисунок 188188: Введите новую линию отсчета для всех пар 

10.4.4.3 Rate-based Compensation  (Компенсация на основе величины интенсивности) 

Данная методика может использоваться, если  показатель потери металла велик. В 
дополнение к расчету по медиане, интенсивность потери металла рассчитывается на основе 
указанного пользователем интервала перед смещением. (Рисунок 190190). Принимая, что 
величина  ∆t - интервал времени между последним значением перед смещением и первым 
значением после него, выражение для расчета базовой линии получается следующее: 

базовая линия = медиана + интенсивность * ∆t 
 

Рисунок 189189 Компенсация смещения на основе величины интенсивности 
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Рисунок 190190: Введите интервалы для расчета Компенсации смещения на основе 
величины интенсивности 

10.4.5 Create single metal loss curve from the mean of a group of pairs (Построить 
одиночную кривую потери на основе данных по группе  контактных пар) 

Данная опция генерирует одиночную кривую потери металла на основе данных по выбранным 
контактным парам. Если в одну группу данных добавлено более 10 пар, эта опция 
активируется автоматически. Включить ее можно, отметив галочкой пункт 'Create single dataset 
from mean of selected data' в окне  'Data group properties' (Свойства группы данных) (Рисунок 
178178). 

10.4.6  Spike control (Котроль пиков) 

Эта опция может использоваться для отсеивания экстремальных величин из набора данных. 
Такие величины являются результатом "зашумленности" данных замеров, и обычно 
проявляются в виде точек данных, резко выделяющихся из общей динамики в наборе. 
Контроль пиков используется только для отфильтровывания пиков, либо слишком низких 
показателей; артефакты иного типа (смещения сигнала, "шум") не обрабатываются. 

Активация этой опции осуществляется в окне 'FSM data processing setup' (Рисунок 174174). 
Отметьте галочкой пункт  'Use spike control' (Использовать контроль пиков), затем нажмите 
кнопку 'Settings' (Настройки). 

Для настройки используется три параметра: 'Amplitude threshold' (Порог амплитуды), 
'Datapoints threshold' (Порог точки данных) и 'Size of average buffer' (Размер буфера средних 
величин): 

� ' Amplitude threshold' (Порог амплитуды) : Это максимальный скачок сигнала между 
двумя точками данных. Удостоверьтесь, что эта величина больше, чем покзатель 
уровня "шума". 
Допустимый диапазон: 1- 1000 частей на тысячу (ppt). 

� 'Datapoints threshold' (Порог точки данных): Максимальное количество 
последовательных точек данных, содержащих пик. Допустимое значение: 1 или 2. 
Данный параметр также определяет время задержки фильтра. 

� 'Size of average buffer' (Размер буфера средних величин): Размер буфера, 
содержащего предварительные величины замеров, используемые для компенсации 
пиков. Если системой определено, что точка данных является частью пика, то она 
заменяется усредненным значением из буфера. Размер буфера должен быть 
достаточно небольшим (макс. 10%) относительно общего количества точек данных. 
Допустимый диапазон: 4- 50 . 

10.4.7  Filter (Фильтр) 
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Системе MultiTrend снабжена сглаживающим фильтром, позволяющим наиболее четко 
отслеживать динамику в сериях данных  FSM. Фильтр работает по принципу "скользящего 
среднего",  при котором каждая точка данных заменяется средним значением из 
буфера.Размер буфера определяет плавность и временную задержку для итоговой кривой 
данных. 
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Активация фильтра осуществляется в окне 'FSM data processing setup' (Рисунок 174174). 
Отметьте галочкой пункт  'Use filter' (Использовать фильтр), затем нажмите кнопку 'Settings' 
(Настройки). Установите значение параметра  'Size of average buffer' (Размер буфера средних 
значений). Допустимый диапазон: 4- 50 . 

Точки данных в количестве  n-1 (где  n - размер буфера), пропускаются без обработки 
фильтром. 

10.4.8 Анализ коррозионных борозд  (сварочного шва) 

Местная коррозия обычно связана со сварочными швами труб. При использовании анализа 
общей коррозии (вершины сварочного шва), могут получаться заниженные показатели степени 
коррозии.Поэтому, был разработан специальный алгоритм оценки глубины равномерных 
коррозионных борозд (коррозия по окружности). 

Для анализа коррозионных борозд требуется следующее: 

- Необходимо определить группу контактных пар. Эта группа должна включать в себя 
только те пары, которые  относятся к исследуемому сварочному шву.Для того чтобы 
выполнить данную операцию, следует воспользоваться схемой матрицы FSM. Как 
определить нужную группу, описано в разделе 10.2.3. 

- Информация об изначальной толщине трубы должна содержаться в базе данных. 
Установка этого параметра производится в реадакторе матрицы FSM ('FSM Pin Matrix 
Editor') (раздел 8.1.4/8.5.4). 

Для того чтобы использовать эту функцию: Откройте окно 'Data group properties' (Свойства 
группы данных) (Рисунок 178178). Установите галочку напротив пункта  'Use groove analysis' 
(Использовать анализ коррозийных борозд), а затем откройте соответствующее меню 
'Settings�' (Настройки). Введите расстояние между контактами, а также предполагаемую 
ширину борозды - оба значения в мм.Ширина борозды может приравниваться к ширине 

сварочного шва; кроме того она должна находится в пределах  (1/3, 2/3)*ТС, где ТС  - 
начальная толщина стенок трубы. 

 
Рисунок 191191 Параметры анализа коррозийных борозд 
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10.4.9 Анализ местной коррозии 

 Анализ местной коррозии - алгоритм, разработанный для оценки питтинговой коррозии. 
Методика оптимизирована под коррозийные язвы, по размеру соответствующие площади 
между 4-мя смежными контактами. 

Для использования данной функции необходимо: 
� Конфигурационный файл 'pair_lay.out' должен быть расположен в подпапке  

"stations"  (в папке 
MultiTrend). Кроме того, схема расположения контактных пар должна представлять 
собой слошную область; все ряды контактных пар должны иметь единую длину. 

Информация об изначальной толщине трубы должна содержаться в базе данных. 
Установка этого параметра производится в редакторе матрицы FSM ('FSM Pin 
Matrix Editor') (раздел 8.1.4/8.5.4). 

� В файле Station.ini,  в секции '[Data 
Processing Settings]' нужно добавить строчку  'DoLCAAnalysis=1' . 

Для использования АМК (LCA): Откройте окно 'Data group properties' (Свойства группы данных) 
(Рисунок 178178). Установите галочку напротив пункта  'Use LCA analysis' (Использовать 
анализ местной коррозии), а затем откройте соответствующее меню 'Settings�' (Настройки). 

 
Рисунок 192192 Свойства функции анализа местной коррозии 

Используется ряд параметров: 

� 'Max L': Количество контактных пар в направлении эл. тока. 
� 'Max K': Количество контактных пар в направлении, перпендикулярном эл.току. 
� Опция 'Pits along the edges' ("коррозийные язвы по краям") позволяет отслеживать 

участки коррозии за пределами матрицы контактов. 
� 'Use initial start values' (Использовать начальные стартовые значения): Отметьте этот 
пункт, если требуется непрерываня серия временных интервалов. 
� 'Maximum number of iterations' (Максимальное количество циклов), обычно от  200 до 
400. 
� 'Stepwise increase in depth' (Пошаговое углубление). Этот параметр определяет 

разрешающую способность анализа; стандартное значение -  0,0001 мм. 

Для оптимизации анализа под коррозионные язвы размером в 1/4 контактного квадранта 
(площадь между 4-мя смежными контактами),  необходимо установить галочку напротив пункта 
'Fine analysis' (Точный анализ). Такой вид анализа применятеся к подсекциям матрицы, 
определяемым величинами L (нижний/верхний) и K (нижний/верхний). Значения 
"нижний/верхний" указывают на определенные контактные квадранты, как показано на Рисунке 
193193. 
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Рисунок 193193: Определение субсекции для точного анализа. Пример 1 (Синий): L 
нижний = 1, L верхний = 2, K нижний = 1, K верхний = 1. Пример 2 (Красный): L 
нижний = 3, L верхний = 4, K нижний = 1, K верхний = 2. Пример 3, вся матрица: L 
нижний = 1, L верхний = 4, K нижний = 1, K верхний = 2. 

ПРИМЕЧАНИЕ: В настоящий момент, функция анализа местной коррозии недоступна 
для обычных пользователей. Доступ к этой функции защищен паролем. 
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10.4.10 Компенсация эрозии на изгибах 

Когда  жидкости, находящейся в трубопроводе, примешиваются частицы грунта, происходит 
эрозия на сгибах.Области поражения обычно имеют овальную форму; они расположены по 
краям внешнего контура изгиба. Кроме того, они различаются по кривизне, глубине, длине и 
ширине, в зависимости от качества жидкой среды и примесей.По причине того, что 
распространение зон поражения по окружности трубы нерваномерно, требуется специальная 
методика компенсации потери металла при эрозийных воздействиях. 

Методика компенсации на изгибах применяется только в случаях, когда предполагается эрозия 
на таких участках.Компенсация производится только для значительных скачков сигнала 
(учитываются только точки данных с показателем более 5 частей на тысячу (ppt)). 

Пошаговое описание процедуры: 

1. Откройте окно 'Data group properties' (Свойства группы данных) (Рисунок 178178). 
Поставьте галочку напротив пункта  'Bend Erosion Compensation' (Компенсация 
эрозии на сгибах). 

2. Нажмите кнопку  'Settings�' и введите предполагаемую ширину и длину зоны 
эрозионного поражения.Допустимый диапазон для ширины:  28°-180° (по окружности в 
360°). Допустимый диапазон для длины:  10°-90° (по сгибу в 90°). 

 
Рисунок 194194: Диалоговое окно для ввода параметров по 
компенсации на изгибах 

Примечание: 
1. Если итоговая скорректированная глубина имеет величину  более 400 частей на тысячу 

(ppt), то рассчитанное значение - это верхний предел. значение в 400 частей на тысячу 
(ppt) - это нижний предел. 

2. Если итоговая скорректированная глубина имеет величину  менее 50 частей на тысячу 
(ppt), то рассчитанное значение - это нижний предел. значение в 50 частей на тысячу 
(ppt) - это, соответственно, верхний предел. 

10.5   Формат вывода данных 

Для построения двухмерной диаграммы доступны 4 вида формата выходных данных: 
 

[ppt/частей на 
тыс.] 

Относительная мера (частей на тысячу) начальной толщины стенки трубы 

[мм] Абсолютная мера, потеря металла, в мм = 10-3 м 
[mils/тысячн. 
дюйм] 

 Абсолютная мера, потеря металла 1 тысячн. дюйма = 0.001 дюйма = 0.0254 
мм = 2.54*10-5 м [мм] Абсолютная мера, потеря металла в µм = 10-6 м 
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11     ПОЛУЧЕНИЕ ТЕХНИЧЕСКОЙ ПОДДЕРЖКИ, ОБРАТНАЯ СВЯЗЬ  

Если вам требуется техническая поддержка в установке, либо использовании ПО MultiTrend, 
или вы хотите сообщить нам о каких либо недостатках/достоинствах программы, либо о 
функциях, необходимых вам, но отсутствующих в программе, пожалуйста, свяжитесь с 
головным  офисом компании CorrOcean, либо с одним из наших подразделений по телефону, 
факсу, электронной либо обычной почте. Электронный адрес отдела поддержки клиентов: 
support@corrocean.no 

11.1   Техническая поддержка 

Если вы направляете запрос по технической поддержке, укажите в вашем запросе следующие 
сведения: 
� Используемую вами версию программы MultiTrend (Можно посмотреть в окне About (О 
программе)) 
� Название используемой вами операционной системы, а также ее версию 
� Тип используемого ПК (тип процессора (CPU), объем оперативной памяти (RAM), объем 
дискового пространства) 
� Настройки коммуникаций на вашем ПК (Номер COM-порта, тип модема, и т.д.) 
� Виды подключаемого оборудования 
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Головной 
офис: 

 
CorrOcean ASA 
Teglgеrden 
7005 TRONDHEIM 
Норвегия 

Телефон +47 7382 5000 
Факс +47 7382 5050 
эл. почта mail@corrocean.no 

CorrOcean ASA, Teglgarden, N-7485 Trondheim, Норвегия, Тел.: +47 73 82 50 00, Факс: +47 73 82 50 50 CorrOcean 

Inc, 3300 Walnut Bend Lane, Хьюстон, Техас 77042, США, Тел.: +1 713 334 2222, Факс: +1 713 266 0172 CorrOcean 

Srl, Via Tiburtina 1470, 00131 Рим, Италия, Тел.:: +39 06 4129 4201, Факс: +39 06 4129 4288 

Также, если вы имеете доступ в Интернет, посетите наш сайт по адресу: 
Адрес:http://www.corrocean.no 
Там можно найти подробную информацию о компании CorrOcean, а также о наших продуктах и 
услугах. 
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